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 1  INTRODUCTION 
 

Industrial Forestry Service Ltd.’s (IFS) CruiseComp cruise compilation program is the most 
comprehensive and widely used timber cruise data compiler in Western Canada. 

CruiseComp is a flexible, user friendly tool for conducting quick inexpensive compilations for 
cutting permit appraisals, forest inventories, research and strategic planning. It will easily 
compile digital cruise data to British Columbia Ministry of Forests’ and private industry standards. 

CruiseComp will allow forestry professionals to complete compilations in-house, quickly and 
efficiently. It will also allow complete control over data management. 

 1.1  Minimum System Requirements 

 Windows 2000, XP, Vista, plus Windows 7, 8, & 10 operating systems 

 Pentium P I processor or equivalent (recommended minimum) with 16 MB RAM 
(minimum) 

 Internet connection (high speed recommended) CD ROM drive, or USB port 

 1.2  CruiseComp Overview 

The CruiseComp compilation process consists of three main steps: 

1. Data entry and compilation set up. 

2. Data validation, and editing 

3. Report generation. 

The program has a variety of modules that are accessed from the main menu to process and 
compile cruise data: 

Map Area  Contains the cruising project identity information, compilation  
Statement specifications and program options. 

Plot Cards Contains the cruise data, based on the BC Ministry of Forests’ cruise card 
(FS 205) format. 

Validate Checks the cruise data and compilation specifications to ensure there are 
no obvious errors, missing information or data conflicts. 

Generate Compiles the cruise data and generate reports for review or printing. 

Preview Selects and displays individual reports. 

Print Selects and sorts reports for printing.  

Set Font Customizes report fonts for display and printing. 

 1.3  CruiseComp Files 

CruiseComp uses and creates a number of files during the cruise compilation process.  

 

ccp file: This is the CruiseComp main file. It contains all the cruise plot data and the Map 
Area Statement information. It is the file CruiseComp uses to compile cruise data. 
It can be opened up and viewed using CruiseComp or MS Access. Report pdfs and 
other output files are created in the same folder where the ccp file is located. 

 

cco file: This file contains the compilation output data. It is generated by selecting the output 
to database icon on the menu bar, then generating reports. The filename matches 
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the ccp file name with a .cco extension. The cco file can be opened up and viewed 
in MS Access. 

 

dat file:  This is the MoF ASCII format text file. The dat file contains the raw cruise data. It 
can also contain some of the Map Area Statement information, and it can be 
imported into or exported from CruiseComp. Dat files can also be imported into or 
exported from cruise data loggers. It is much more compact than a ccp file and is 
well suited for attaching to e-mails. The filename is normally the name of the ccp file 
with a .dat extension but, it can be modified by the user. 

 

cct file:  This is the IFS ASCII format text file. It is similar to the MoF dat file, but can store 
more Map Area Statement information, such as block description labels, longer 
type and plot numbers, plus the percent reduction specifications. The filename is 
normally the name of the ccp file with a .cct extension, but it can be modified by the 
user. 

 

pr file:   This is an ASCII format text file containing the percent reduction information only. 
It can be imported into or exported from CruiseComp. The filename is normally the 
name of the ccp file with a .pr extension, but it can be modified by the user. 

 

csv file:  This is a new file format requested by the MoF in 2013. It is a comma delimited (csv) 
ASCII text file providing cutting permit, block, and harvest method summary 
information. It can be opened and read by a text editor or MS Excel.  This file is to 
be included in a cutting permit application to the MoF. Whenever a “For Appraisal 
Purposes Only” or “For MPS Purposes” compilation is run, a csv file will be 
created.  The csv file(s) will be found in the same folder the ccp is located, provided 
the ccp file was opened with the File -> Open option on the menu bar. The file can 
be generated using full volumes and percent reductions. Filenames are as follows, 
with a .csv extension: 

 

license-cp-lf   loss factor full volumes 

license-cp-lf-r   loss factor with reduction 

license-cp-cgnf    call grade coast cruise full volumes 

license-cp-cgnf-r   call grade coast cruise with reduction 

 

ie. 

A12345-987-lf       loss factor (coast or interior), full volumes 

A12345-987-lf-r     loss factor (coast or interior), percent reduction 

A12345-987-cgnf     call graded coastal, full volumes 

A12345-987-cgnf-r call graded coastal, percent reduction 

 

For further information on csv files go to:  https://www2.gov.bc.ca/assets/gov/farming-natural-resources-
and-industry/forestry/timber-pricing/timber-cruising/csv_file_description.pdf    
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xml file: This is the IFS Interior Appraisal xml file. It is exported from CruiseComp after 

compilation reports have been generated. It is then imported into the IFS Interior 
Appraisal program. The filename is the name of the ccp file with an _appr.xml 
extension. It is not generated automatically. The user must use the Export 
Appraisal XML command found under File on the Main menu bar. 

out file:  This is the ASCII text file format for CruiseComp reports. They are created when 
reports are generated and printed to a printer or pdf document. The file name is the 
name of the report with an .out extension.  Ie.  Block.out, allmeth.out, cp.out, 
apprsum.out etc. Creating out files is optional. The user can go to the File 
Configuration dialogue and select or deselect Enable Report .out files. 

 

 1.4  CruiseComp Main Screen 

 

 

 

 
Figure 1- CruiseComp Main Screen 

Note: if the Print Report, PDF Report, and Preview Report buttons are greyed out, it is because 
reports have not been generated (compiled) for the data currently loaded into CruiseComp. 
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 1.4.1  Toolbar 

Display or hide the Toolbar by selecting it from the View Menu. 

 

   

   

 

 

 

 

  

  

 

Figure 2- CruiseComp Toolbar 

 

 1.4.2  Status Bar 

Display or hide the Status Bar by selecting it from the View Menu. 

 

 

 
 

 

Figure 3- CruiseComp Status Bar 

 

Please note the CruiseComp status changes to the command name of each icon as the mouse 
cursor passes over it. 

 1.5  Other CruiseComp Modules 

The following is a summary of modules that are not part of the core module but are available as 
additions to the CruiseComp core module. 

 1.5.1  Cruiser Call 

The Cruiser Call Module is used to compile the true log quality of each tree using cruiser called 
grades and net factors rather than using arbitrary computer algorithms to determine log grades. 
It is used primarily for coastal compilations but can be used for interior ones as well. 

 1.5.2  End Use Sort Module 

The End Use Sort Module estimates volumes for user specified end products. It requires an 
End Use Sort matrix which is based on historic scale data from the surrounding area. 
CruiseComp compiles the cruise data and summarizes it in a number of different ways, and 
displays it in easy to read reports. This module is used in conjunction with the Cruiser Call 
Module. 

Enable Output to 
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Create New Project 

Save Project Map Area Statement 

Change Report Font Delete a Tally Plot 

Add a Tally Plot 

Merge 
Modul

Export Data 

Validate Data 

Generate (Compile) Reports 

Print Reports 
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Current File 
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Plots Selected 

Process Timer 

Import Data 

PDF Report 
Writer (New) 
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 1.5.3  Cruise Data Merger 

The Cruise Data Merger Module makes the process of combining cruise data from different ccp 
files into one much quicker and easier than just importing dat files. 

 1.5.4  Forest Inventory Module 

The Forest Inventory Module is used to calculate Site Index, generate timber type labels, 
and summarize cruise data into customized stand layers by plot and by timber type. 

 1.5.5  Log Analysis 

The Log Analysis Module sorts logs by user defined diameter classes, making it easier to see 
the stand log profile. 

 1.5.6  Sub Species 

The Sub Species Module allows species to be broken down into sub categories based on criteria 
such as Tree Class, Damage, and diameter range, for compilation purposes. 

 1.5.7  Custom Log Length 

The Custom Log Length Module allows trees to be broken down into user defined log lengths 
instead of fixed log lengths.  The user can break down the logs by species, min/max butt 
diameter, min/max top diameter, log value and more. 
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 2  CRUISE COMPILATION SEQUENCE  
The following is a general guideline for compiling a typical timber cruise.  

The user should know the Forest Inventory Zone, utilization specifications, number of blocks 
and harvesting methods in the cutting permit and the hectares by type within each block and 
harvest method(s) before setting up the compilation. 

 

Important!: All work should be saved frequently and backed-up regularly. 

 2.1  Starting the Program 

Start CruiseComp by double clicking on the CruiseComp icon.  

To start a new CruiseComp file, select New from the File menu or click on the  icon. This 
creates an empty database file where the user can manually input data or import a dat or cct 
(ascii text) file.  

To import a dat or cct file click the import   icon. Then navigate to the folder where the data file is 
located. 

To load an existing CruiseComp file, select Open… or click on the  icon. You will now be 
able to access the main menu. 

 2.2  Entering Project Data 

In order to run CruiseComp, the utilization specifications, type/block areas and harvest method 
areas must be specified for the Cutting Permit.  To do this, select Map Area Statement from 

the Edit menu or click on the  icon.  

 

These are the cards used for a basic compilation. Each card appears as a separate screen, 
accessed by selecting one of the tabs at the top of the page.  It is recommended to complete 
them in the order shown, starting with the Cruise Identity, to avoid data entry problems. 

 cruise identity 

 compilation standard 

 types 

 blocks  

 treatment units  

 harvest methods  

 areas  

 non-merchantable areas (optional) 

 height curve (if applicable) 

Once all the screens are completed, select ‘OK’ at the bottom of the screen to return to the 
Header (Card 9) screen. 
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 2.3  Importing or Entering Cruise Data 

 2.3.1  Importing From A Dat or Cct file 

To import cruise data from a dat or cct file, click on the new  icon to create a new shell file. Click 

on the Import Data   icon and the Import Data box will pop up.  Look at the bottom for the 
Files of type: box.  

 
Click on the selection arrow and select from the following choices: 

 MoF data file (*.dat) 
 CruiseComp data file (*.cct) 
 MoF and CruiseComp data files (*.dat, *.cct) 
 All files (*.*) 

After making a selection, only the files of the selected type will be shown. 

Navigate to the folder containing the target data file and click on it. The filename will appear in the 
File Name box at the bottom. Click Open, and the file will be imported into CruiseComp. The user 
should then go to the Menu bar, click File Save As, give the file a name, and click Save to complete 
the import process. 

 2.3.2  Opening an Existing CCP file 

To open an existing ccp file, click the Open  icon, then navigate to the folder containing the 
target ccp file.  

 
Click on the file and click on the Open button. The file will now load into CruiseComp. 
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 2.3.3  Inputting Cruise Card data 

To enter new plot cards, select Add Tally Sheet from the Edit menu, click the   icon, or press 
the + key.  Add Tally Sheet displays a split screen with cruise plots listed on the left side of the 
screen by block, strip, plot and type number.   

Header (9 card):   Contains the header information for each plot 

Trees (2 card): Contains the individual trees for each plot 

Grades (2a card): Contains the cruiser call net factor data 

User Grades: Contains user defined grades 

Sample Trees (3 card):  Contains the sample trees used for compiling height 
curves 

Growth Rates (5 card): This information is only input when directed and is not 
required to run the CruiseComp. 

For each plot, enter the header (9 card), tree (2 card) and sample (3 card) information.  To add 
another plot, click the ADD Tally Sheet icon and repeat the previous steps.  If it is discover that 
a card was entered in error or accidentally duplicated, highlight the plot in the list and select 

Delete Tally Sheet from the Edit menu, click the    icon, or press the - key. 

 2.4  Validating and Generating Reports 

Once all the plot data has been entered and the Map Area Statement cards have been 

completed, click on the Validate  icon to validate the project data.  

Once any validation errors have been corrected, click the Generate Reports  icon.  The 
program will automatically save the project and validate the data again before generating the 
reports.  

If a compilation is set for Not for Appraisal Purposes, validating the project data is optional 
when using the Generate Reports command. 

 2.5  Printing 

After CruiseComp has finished generating the reports, the program will ask to print reports. 
Selecting Yes brings up the Print Options Dialog screen, allowing the user to choose which 
reports zwish to print. The reports will print in the order selected from the Reports to Print 
window. If you decide not to print reports immediately after compiling, they can still be printed 

out without having to regenerate reports. Clicking the Print Reports  icon will bring up the 
Print Options Dialog, provided the cruise data or the Map Area Statement have not been 
changed. The Print Reports icon and the Preview Reports icon will be grayed out if reports 
are not available for printing. 

  



CruiseComp User Manual   

 Industrial Forestry Service Ltd 9 

 

 2.6  Exporting to a Dat or Cct or Csv file 

 2.6.1  Exporting to a Dat or Cct File 

To export to a dat or cct file, data must already be loaded into the CruiseComp program. Click on 
the Export Data button. When the Export Data box pops up, enter a filename. CruiseComp will 
automatically export to dat and cct file types, so there is no need to change the Save as type: 
option. Click the Save button and the data will be exported. 

 2.6.2  Exporting to a CSV File 

CSV files are exported automatically when cruise data is compiled. Each csv file will have an identifier 
inserted in the file name showing which compilation pre-set was used. 

 

lf = Loss Factor 

lf-Non_Appr = Not for Appraisal 

cgnf = Cruiser Call Grade 
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 3  MENU OPTIONS 

 3.1  File 

 
Figure 4- File Menu 

 3.1.1  Create A New Cruise Project 

 Select New Project from the File menu, click the    icon or press <ctrl> N. 

CruiseComp creates a shell file that is ready to accept cruise data directly from keypunching 
or imported from an ASCII file in dat (MoF) or cct (IFS) format (see sect 2.1.16 Import and 
2.1.17 Export (ASCII Format) Data). 

 3.1.2  Create A New Stump Cruise Project 

 Select New Stump from the File menu. 

CruiseComp creates a shell file that is ready to accept stump cruise data direct from 
keypunching or from an ASCII file in dat (MoF) or cct (IFS) format (see sect 2.1.16 Import 
and 2.1.17 Export (ASCII Format) Data). 

Please note, a new stump cruise project cannot be created by clicking the New icon on the 
CruiseComp Toolbar. It can only be done by using the File menu. 

 3.1.3  Open Project 

 Click the    icon, select Open Project from the File menu, or press <ctrl> O. 
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Figure 5 - Open Project 

 

Look in: Select the drive and directory where the project is located by clicking the 
dropdown arrow. 

File name: Either enter the specific project file name or highlight it in the directory 
listing. 

Files of type: Select the file format required to open the project file. Cruise 
Compilation Files (*.ccp) or All Files (*.*). 

 3.1.4  Save Project 

 Select Save Project from the File menu or click the    icon. 

If the project has been previously saved, any new edits/additions will be automatically re-
saved under the same filename. Otherwise, a Save As dialogue box (see section 3.1.5) will 
appear, requiring the user to select a directory and enter a file name to save the file under. 

 3.1.5  Save Project As 

 Select Save Project As from the File menu. 

 
Figure 6 - Save Project As 

Save in: Select the drive and directory where the project will be saved by clicking 
the dropdown arrow. 

File name: Select a file to overwrite by clicking the dropdown arrow or enter a new 
name for the project to be saved. 

Save as type: Select a file format to save the project in by clicking the dropdown 
arrow. The options are Cruise Compilation Files (*.ccp) or All Files (*.*) 
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 3.1.6  Close 

 Select Close from the File menu, to close the current file without exiting CruiseComp. The 
program will prompt you to save any edits or changes. 

 3.1.7  Configuration 

 Select Configuration from the File menu.  

Configuration allows the user to set how CruiseComp will respond to certain commands. 

 
Figure 7 - Configuration Dialog 

 

 Prompt before validating Non-Appraisal Compilation 

When checked, CruiseComp will ask to validate the data before generating reports, when 
running a Not for Appraisal Purposes compilation. The program will automatically validate the 
data when it is not checked. 

 Prompt before Printing 

If this box is checked, CruiseComp will ask if the reports are to be printed immediately after 
they are generated. This option allows you to make changes to the report list and/or the printer. 
Otherwise, the previously selected report list will be printed automatically without an opportunity 
to edit the selections. 

 Print Graphics on Reports 

If this box is checked, all line graphics (chart lines, grids and height curve) will be displayed in 
the reports. 
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 Save Generated Height 

Generates and saves heights from a height curve for any trees on the Trees (Card 2) tab that 
does not have a height recorded in the height column.  

Important!: Please note that once this option has been run, new heights will not be generated 
from height curves during subsequent compilation runs. Therefore, it is recommended to make 
a backup copy of the file before running this option in case changes need to be made before the 
results are made final. 

 Show Highlights on Reports 

Creates shading on reports to increase readability. 

 Prefer CCBC PDF to printing 

This is a new feature. It sets the default to CruiseComp PDF Writer (as opposed to using Adobe 
pdf writer or a 3rd party pdf writer) when a prompt for printing pops up after compiling.  

 Enable Report .out files 

Enable/disable the creation of *.out files. Out files are ASCII format files that contain a 
reproduction of the compilation reports being generated. 

 Dump Compilation to .csv (inc’l BH Comp, Grade Sort & BH Grade Sort) 

Enable/disable the creation of .csv files. The .csv files are comma delimited ASCII files containing 
output from the CruiseComp compilation. These files can be opened and viewed in any text 
editor program or in a spreadsheet such as MS Excel. BH refers to Block by Harvest Method. 

 Output to Database 

Compilation output data is automatically saved to a database file. The database format is 
selected by clicking the DB Info button. Output options include MS Access, SQLite, and 
PostgreSQL. 

This option may significantly increase the compilation time and may result in an extremely large 
output file. Therefore, this option should only be selected if you need to work with the output 
data in a database. The output file will have the extension *.cco. 

To quickly activate or de-activate the Output to Database option, click the   icon located 
on the CruiseComp Toolbar. 

 Compile Based on Output Requirements Only 

If this box is checked, only those tables checked off in the table list will have will have data 
output to them. The Select All button selects all the tables in the list. The Deselect All button 
removes all tables from the list. 

Using this feature may help reduce compilation time, particularly for very large datasets. 

DB Info 

 3.1.8  Import and Export (ASCII Format) Data 

CruiseComp has the ability to import or export cruise data from/to MoF format (*.dat or *.mof) 
and IFS format (*.cct) ASCII text files. This allows for importing of data (excluding certain 
compilation set up information) from earlier versions of CruiseComp and to exchange data with 
other MoF approved compilation programs. 

Tree class 4 or 6 trees will be deleted from count plots when files are imported into or exported 
from CruiseComp. Tree class 4 or 6 trees are not to be tallied in count plots nor are they to be 
compiled. 
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When dealing with MoF format files, the Percent Reduction Table has to be imported or 
exported separately using the Load or Save functions on the Percent Reduction page. The 
Percent Reduction Table is included in the IFS format (*.cct) ASCII file. 

 3.1.9  Importing Cruise Data 

To Import existing data: 

 Open CruiseComp 

 Select New Project or Open Project from the File menu or click on the  icon or 

the  icon. 

 Select Import Cruise Data from the File menu or click the   icon. 
 Navigate to the target directory 
 Select the appropriate file extension and file you wish to import. 
 Select Open. 

 
Figure 8 - Import Data 

 

Look in: Select the drive and directory of where the import file is located.    

File name: Enter the project file name or highlight the file in the directory listing. 

Files of type: Pick one of four options, MOF Data file (*.dat), CruiseComp data file 
(*.cct), MOF or CruiseComp data files (*.dat ; *.cct), or all files (*.*). 
CruiseComp will only display those files in the current directory that have 
the selected file extension.  

Note:  When importing new data into an existing file you will be asked if you want to “append 
to existing data?” Selecting no will over-write any existing data. Selecting yes will add 
the import data to the existing data. When you select the yes option, any updates in the 
Map Area Statement must be made manually, as this operation only brings in the plot 
data. The Cruise Data Merger module automates most of this process. 

When CruiseComp imports cruise data, it checks that the forest region and district codes are 
current. If it detects codes that are pre-2003, it will advise the user, and ask to update the codes 
(see figure 9). If the user says yes, the region and district codes will be updated to the current 
ones. If the user says no, CruiseComp will import the data, but the region & district codes will 
be left blank. 
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Figure 9 – Region and District code warning 

The user must ensure that the forest region and district codes have been converted correctly. 
 3.1.10  Exporting Cruise Data 

To Export data: 

 Open CruiseComp 

 Select Open Project from the File menu or click on the  icon  
 Navigate to and open the file to be exported. 

 Select Export Cruise Data… from the File menu or click on the  icon. 
 Choose a file name and a format for the export file. 
 Select Save. 

 

 
Figure 10 – Export Data 

 

Look In: Select the directory of the project to be exported. 

File Name: Enter a file name for the exported data. The file extension is not necessary. 
It will be assigned automatically according to the file format selected in the 
Save as type box. 

Save as type: Pick one of two options, MOF Data file (*.dat), CruiseComp data file 
(*.cct).  

 3.1.11  Export Appraisal XML 

The Export Appraisal XML feature was created in 2011. Compiled data, which has been output 
to a cco file, can be exported to an XML file and used in IFS’s interior appraisal program. 

To use this feature, compile the data with Enable Output to Database selected, then select 
Export Appraisal XML from the File menu. The XML file will be generated in the same folder 
as the CCP file. 

 3.1.12  Import and Save 

Use the Import and Save command to import ASCII format files in bulk and automatically save 
them as CruiseComp *.ccp files. This process can be repeated without closing files. 



CruiseComp User Manual   

 Industrial Forestry Service Ltd 16 

 

 Select Import and Save from the File menu. 

 Navigate to and select the group of files to be imported into CruiseComp. 

The batch of files being imported may contain files that have been created by different versions 
of CruiseComp or by a compilation program other than CruiseComp. If possible, separate the 
files into batches. Files created by CruiseComp before 2003 should be kept together in one 
batch, files created by CruiseComp in 2003 & later should be kept in another, and files created 
by other compilation programs should be put in their own batches. This will avoid problems with 
the importation of the Forest Region and District codes, as mentioned in section 3.1.9. 

 3.1.13  Merging Cruise Data (Cruise Data Merger 
Module) 

This module allows the user to merge blocks, types or a selection of plots from one CruiseComp 
project into another.  

 Select Merge from the file menu, or click the   icon  

 

Look in:  Select the directory where the file to be merged (source file) is located. 

File name:  Type the file name or highlight the file in the directory listing. The file must 
be in a CruiseComp format and should have a *.ccp extension. 

If there is a mismatch in the cruise identity information, a warning message will pop up. The user 
must then decide whether to continue or not. Selecting No will stop the merge. Yes will continue 
it to the next step. 

 
Figure 11 – Merge Data Warning 

The Project Display Mode determines if the merge will be by block or type. It must be selected 
before setting any other merge parameters. 

 3.1.14  Merge Parameters 

The merge parameters determine what areas are merged from the source file.  

Copy non-merchantable areas merges the non-merchantable areas and descriptions. 

Copy treatment unit areas merges type descriptions, block descriptions, treatment unit areas 
by type on the block tab and treatment unit descriptions located on the treatment unit tab of the 
map area statement. 

Recalculate type TU areas adds the treatment unit areas by type from the source file to the 
destination file. If Copy treatment unit areas is unchecked then this option is not available. 

Overwrite Project Identity and Standard overwrites the cruise identity & compilation standard 
information in the destination file with information from the source file.  

 3.1.15  Merge Block(s) or Type(s) 

To merge data from one project to another, simply drag a block, or type from the Project to be 
Merged side of the window and drop it into the Current Project side of the window.  When all 
items have been moved, select OK, and a series of prompts will come up asking questions about 
the identity and destination of the merge items.  The user can customize the merge through this 
intuitive process. 
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The block and type areas are transferred in accordance with the parameters set on the Merge 
Project page. 

Blocks with the same IDs or descriptions cannot be merged together. They must be unique. 
However, type merges are allowed.  

 3.1.16  Merge Individual Plots 

To select individual plots for merging, double click on a block or type. The plots will drop down 
and are ready to be selected for the merge. Click on the desired plots and then drag and drop 
them into the target block or type.  

Areas are not transferred over when plots are selected for merging. Pressing the Reset All button 
will hide the plots. 

 
Figure 12 – Merge Project 

Harvest Method areas are not included in a transfer. They must be added in manually after 
the merge is complete.  

 

 3.2  Print Setup 

Print Setup is used to configure how reports will be printed within the CruiseComp program. 

 
Figure 13 – Print Set Up 

 

 3.3  Adding Plots 

 Select Add Tally Sheet from the Edit menu, or click the    icon or press the “+” key 
on the numeric keypad. 
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This allows the user to add a new plot to the compilation.  It appears as a new entry at the 
bottom of the plot listing with the accompanying blank cruise tally sheet (Header Card) ready to 
be filled out. 

 3.4  Deleting Plots 

 Select one or more plots to be deleted by clicking the first one then holding down the 
Shift key and selecting the last plot in a consecutive list of plots to be deleted, or holding 
down the Ctrl key and clicking on individual plots. 

 Select Delete Tally Sheet from the Edit menu, or click the    icon or the “-“ key on 
the numeric keypad. CruiseComp will request confirmation that the selected plots are to 
be deleted, click yes and the highlighted plots will be permanently removed from the file. 

 3.5  Validation 

Validate is the CruiseComp module that checks the field data and compilation specifications to 
ensure the data is complete and free of obvious errors or conflicts. An onscreen Validation 
Error report is produced, listing all the errors and warnings found and sorted into categories 
(see figure 14). The error reports include a brief description to assist the user in locating and 
correcting errors. 

 

 
Figure 14- Validation Table of Errors and Warnings 

 Select Validate from the Reports menu or click the    icon. 

 If obvious compilation errors exist, a dialogue will pop up.  

 Click OK on the Validation Errors warning dialogue,  

 Click on one of the Errors or Warnings tabs to check for possible compilation issues. 

When Validate is run, a file is produced within the working directory called errors.dat.  This is an 
ASCII text file listing all errors and warnings produced. A hardcopy of the report can be produced 
by clicking the Print button at the bottom right of the screen. See Appendix I Validation Errors 
for a complete list of possible errors and warnings. 

In For Appraisal Purposes compilations, all errors must be corrected before a dataset can be 
compiled. Warnings do not necessarily mean that there is a problem with the compilation. They 
indicate that there may be a problem that should be looked at. A compilation can be run with 
warnings present, so it is at the user’s discretion whether to check & correct them or not.  

Block # 

Type # 

Strip # 

 

Plot # 
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Important!: Please note that the validate module will only catch errors in the data that exceed 
predetermined parameters, or there are conflicts in the data file. Therefore, the cruise data should 
always be visually checked for less obvious errors such as typos or transposed numbers. 

 3.6  Generating Reports 

Generate is the CruiseComp module that compiles the cruise data and creates the various 
reports.   

The Generate module performs four critical functions: 

1. It performs an automatic save of data and reference information in the cruise 
compilation project.  

2. It runs the Validate module prior to compiling the data.  If errors are 
present in the data, they must be corrected before reports can be generated. 
If no errors exist, the module will proceed. 

3. It calculates all tree and log volumes.  

4. It generates reports for review using the Preview module and/or printing 
using the Print module. 

 

To generate reports: 

 Select Generate from the Reports menu or click the  icon on the CruiseComp toolbar. 

 3.7  Calculation Error Report 

CruiseComp now reports on errors, other than validation errors, that will cause a compilation to fail. 
The Calculation Error Report gives a brief description in a pop-up dialogue that should help the 
user track down the problem.  

The example below shows the calculation error for a tree that has an unrealistically low site index. 

 
Figure 15 – Sample Calculation Error Report 

 

 3.8  Preview Report 

 Select Preview Report from the File menu or click the    icon 
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 To preview a report prior to printing, simply click on the report name you wish to 

preview from the Select report to preview: list and click OK, or just double click on it.  
Reports must be generated prior to selecting the preview report option. 

 3.9  Print Reports 

 3.9.1  CruiseComp PDF Writer 

CruiseComp PDF Writer produces pdf reports with bookmarks, without needing to use a third 

party PDF writer program. Click the  button on the CruiseComp tool bar or the Print to 
PDF command on the File menu.   

A check box on the File Configuration Dialogue allows the user to set the default to 
CruiseComp PDF Writer for the prompt immediately after compiling. Leaving it unchecked 
means the default is a choice of an installed printer or a third party pdf writer if installed.  

PDFs can still be produced the same as before, using the Print Reports menu or the  icon. 
However, a third party PDF writer program, such as Adobe Acrobat will still be needed for pdfs 
when using this option. 

 

 3.9.2  Report Options Dialogue 

The Report Options Dialog screen allows the user to select and sort reports for printing. 

 Select Print Reports or Print to PDF from the File menu, or click the  or  
icon. 

 

 
Figure 16 - Report Options Dialogue 

 On the left-hand side of the window, click on one of the + signs to reveal the reports in 
one of the report categories. Click on a – sign to hide a report or report category.  

 To add a report to the print list located on the right-hand side, click the check box beside 
the desired report. It will then appear in the print list. Repeat this until all of the required 
reports are selected. To select all reports in a report category, check the box beside the 
category heading. 

 The reports will be printed in the order they appear in the print list, starting at the top. 
To change the printing order, click on a report and then press the Move Up or Move 
Down buttons to change its location on the list. 
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 Select Save and enter a name to save a frequently used list of reports. 

 Select Load to recall a saved list of reports. 

 Select Remove All to clear all reports from the print list 

 

The black check marks in the Report Options dialogue indicate that all reports in that report 
category have been selected. Whereas, all the grey check marks indicate that only some of the 
reports have been selected. 

CruiseComp will remember the print settings from the previous print job. For example, if the 
program used landscape the last time, the next time the program will print in landscape.  

For printers that print double sided, the reports will start on the first page for each new report. 

 

 3.10  Font 

 Select Font... from the Reports menu or click the    icon to change text characteristics 
(font, font style and size) applied to the reports. 

The default font settings are shown in figure 17. 

 
Figure 17 - Report Font Menu
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 4  MAP AREA STATEMENT 

 Select Map Area Statement from the Edit Menu or click the    icon to view the project 
data. 

The Map Area Statement screen contains sixteen tabs depending on how many modules the user 
has purchased. Eleven are directly applicable to the CruiseComp core module. The others apply to 
some of the various add-on modules (see section 1.4) that are available for CruiseComp. These 
cards provide detailed information concerning the area of interest. 

The applicable tabs must be completed prior to running the compilation. 

 

 
Figure 18 – Map Area Statement 

 

Cruise Identity  Establishes the cruise location and administrative parameters. 

Compilation Standard Defines the compilation parameters. (ie. Utilization limits, 
calculation method, exceptions, etc.) 

Types Assigns a descriptive label to each type or stratum. Areas are 
no longer input on this tab. 

Treatment Units Creates new treatment units and assigns a descriptive label to 
each. Up to ninety-nine treatment units are allowed in a 
compilation.  

Treatment units are used to identify or isolate portions of the 
permit area that will be treated differently. Examples of 
different treatments would be areas with different percent 
reductions or different harvest methods. 

Non-merchantable     Identifies any non-merchantable or non-harvestable  
Areas      areas.  

Blocks Lists all cutblocks in the compilation, including descriptive 
labels, maturity (coastal), plus total merchantable and non-
merchantable area(s). Merchantable areas are no longer input 
on this tab 
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Harvest Methods Contains the available harvest method codes and descriptive 

labels. 

Areas Combines the type, block and harvest method areas all in one 
spot. 

Height Curve Contains the settings to build height curves for generating tree 
heights. 

Height Equations The height equations screen permits the user to custom build 
a height curve for a species and type when there are no 
available sample trees or when the user is unable to combine 
species in a height curve. Height equations are normally used 
for very minor or deciduous species.  

Grades  Contains the settings related to log grades. Most of this tab is 
(Cruiser Call Module) locked when one of the pre-set radio buttons, other than the 

None setting are selected on the Cruise Identity tab. The 
Cruiser Call Module allows the true quality aspects of the logs 
to be compiled in a stand or cutting permit, instead of relying 
on computer algorithms to derive log grades.  

Percent Reduction Allows for net volume reductions on user selected portions of 
a cruise. The percent reduction factors are entered by species, 
timber type, risk group/tree class, block, treatment unit, 
damage code, and/or DBH class. 

Log Analysis Allows the user to create a customizable log profile for a 
(Log Analysis Module) cutting permit, block or type, enabling the user to better 

understand the log population. 

Forest Inventory Enables the user to select and calculate site index trees, and 
(Forest Inventory Mod- summarize cruise data and a variety of calculated fields 
ule)  into customizable layers by plot and timber type. 

Sub Species Allows selected species to be broken down into user defined sub 

(Sub Species Module) categories. 

Custom Log Length Allows rule based customized log lengths 

(Custom Log Length   

Module)  
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 4.1  Cruise Identity Card 

This card describes the location and nature of the area of interest. 

 

 
Figure 19- Map Area Statement - Cruise Identity Card  

 

Administrative/Legal Name of the jurisdiction that administers the area of  
Jurisdiction interest. 

Licensee: Name of the tenure holder or land owner 

Cruised by: Name of the person or company that cruised the area of 
interest 

Project #: A user-defined project number which uniquely identifies the 
compilation 

Licence: Tenure number 

Permit: Cutting Permit number 

Blocks: The number of blocks in the compilation.  

Area: The total area (hectares) contained within the area of interest. 

Elevation: The elevation at the center of the area of interest. 

Region: Forest Region in which the area of interest is located.  (select 
from the pull-down menu). The region codes are updated to 
reflect the current MoF organizational structure. Please be 
aware that when importing data, the old forest region and 
district codes will be updated or deleted depending on user 
input. 

District: Forest District in which the area of interest is located. (Select 
from the pull-down menu). The district codes are updated to 
reflect the current MoF organizational structure. Please be 
aware that when importing data that the old forest region and 
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district codes will be updated or deleted depending on user 
input. 

FIZ: The province is divided into 12 Forest Inventory Zones (FIZ’s) 
– A, B and C are Coastal zones; D to L are Interior zones. The 
correct zone is crucial to the proper application of volume 
equations and loss factors (select from the pull-down menu). 

Tenure: Tenure description. Select from the pull-down menu. 

Quota: Quota type description. Select from the pull-down menu. 

Sale Type: Sale type description. Select from the pull-down menu. 

Report Type: Indicates whether the compilation is to be used FOR 
APPRAISAL PURPOSES or not.   FOR MPS PURPOSES is 
used for Coastal CGNF compilations for 2008 and onward and 
is distinct from appraisal Loss Factor compilations.  Select 
from the pull-down menu. 

Locality:  Enter a brief description of where the area of interest is 
located.  (OPTIONAL) 

Unit ID Type: Select the type of unit the area of interest is located within. 
Select from the pull-down menu. 

Unit ID #: The identity number matching the applicable Unit Identity 
Type for the area of interest.  Select from the pull-down menu. 

Zone: The UTM zone in which the area of interest is located. 
(OPTIONAL) 

East: The UTM Easting coordinate for the area of interest 
(OPTIONAL) 

North: The UTM Northing coordinate for the area of interest 
(OPTIONAL) 

Presets Select one of four presets (None, Coastal CGNF, Coastal or Interior 
Loss Factor) 

The Presets option instructs the program to select and lock any required settings. Locked settings 
are grayed out and cannot be selected or changed. 
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 4.2  Compilation Standard Card 

This card sets many of the compilation specifications. 

 
Figure 20 -  Map Area Statement - Compilation Standard Card 

 4.2.1  Damage Report 

The Damage Code switch enables the use of all damage codes on the Card 2 records: root rot 
only in column 60, insect damage in column 61, fire damage in column 62 and blow-down 
damage in column 63.  See Appendix IV for valid codes. The damage options to choose from 
are: 

  

 Damage Report – default for appraisals is to have this checkbox checked, which enables the 
program to compile the damage codes. 

 Root Rot Report – compiling for root rot is optional, therefore the checkbox is not 
selected. 

 

All damage types will be compiled in a single cruise. If multiple damages occur on a single tree, 
the most severe damage type for net volume will be compiled. If two damage types have equal 
effect on risk group for a single tree, then the precedence is Blowdown/Fire/Insect.  

 

 4.2.2  Cutting Indicator 

The cutting indicator radio buttons allow for the compilation of Cut/Leave cruises.  It uses the 
indicators placed on each individual Card 2 record (column 59) and Card 3 (column 40).  The 
three radio button options are: 

 Compile All Trees 

 Compile Cut Trees Only – only trees with a BLANK or C will be compiled 

 Compile Leave Trees Only – only trees with an L will be compiled 
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 4.2.3  Double Sampling 

To compile measure and count plots, select the “Apply Double Sampling (Include Count 
Plots) checkbox.  Measure plots are compiled and the program adjusts the measure plot volume 
by the double sampling factors derived from the count plots.   

The statistics report will show the statistics for the measure plots alone (measured weighted 
sampling error) as well as the count/ measure plots combined (weighted sampling error). 

Important!: If it is unclear what  the  minimum DBH limit will be at the time of cruising. Record 
the DBHs of all count plot trees that are less than the largest possible minimum DBH. 
CruiseComp will automatically drop any trees smaller than the selected minimum DBH. 

 4.2.4  Type of Compilation 

The combo box has two options, choose either Interior or Coastal. 

Note:  In order to create a Volume and Lumber Recovery Factor Report (LRF), this switch 
must be set to the Interior option.  To create the Ministry of Forests’ Log Grades Reports, the 
switch must be toggled to the Coastal option. 

The options are: 

 3 - Interior  (default) 
 32 - Coastal 

 

 4.2.5  Utilization Limits 

The Utilization Limits specifies the DBH limit, stump height and top diameter for the 
mature and immature utilization levels within the area of interest.  

Note:  Coastal compilations can use mature and/or the immature utilization limits. They are 
applied on a block by block basis. Interior compilations only use mature utilizations for 
cutblocks. 

 

 4.2.6  Use Exceptions 

Use Exceptions indicates whether all species in the compilation are to be compiled with the 
same utilization specifications or whether an exception to the utilization limits is to be applied to 
selected species. 

The default for appraisals is to have the checkbox selected.  This will compile the utilizations 
found in the spreadsheet. 

 

 4.2.7  Standard Log Length 

There are three options for standard log lengths:  

 Coastal algorithm grades (for appraisal) - 10 m 

 Coastal CGNF grades (for MPS Purposes) - 13 m 

 Interior compilations (for appraisal) – 5 m 

 

 4.2.8  Global Min Log Length 

This option is only available when the None pre-set is selected on the Cruise Identity tab. To 
take advantage of a customized Global Min Log Length, first select the pre-set on the Cruise 
Identity tab that is the closest match to the required compilation specifications. Go to the 
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Compilation Standard tab, check that the pre-set settings are correct, then go back and set 
the pre-set to None. Return to the Compilation Standard tab and the Global Min Log Length 
can now be changed. The default minimum log length is 2.5 meters. 

 4.2.9  Grade Specific Min Log Length 

This option is automatically selected when the Coastal CGNF pre-set is selected on the Cruise 
Identity tab. The pre-set must be set to None to make it an available option. When compiling 
cruiser call grade compilations, Grade Specific Min Log Length should be used. The program 
will then determine the minimum log length based on log grade.  Most minimum log grades are 
5 meters, with the exception of Y (3m), N (1m) and Z grades (1m) and some heli grades.   

 4.2.10  Special Compilation 

The wet/dry belt fir radio buttons are only used for cruises which fall within the Interior 
regions of British Columbia (FIZ zones D-L).  If there is no Douglas-fir in the dataset, it will not 
matter which setting is chosen as it will have no effect on the compilation. 

The three radio buttons are: 

 No Special Compilation (for coastal compilations) 

 Interior Wet Belt Fir 

 Interior Dry Belt Fir 

 

 4.2.11  Calculation Method 

The compiler has the choice of using the average line or block method calculation method only 
when the None pre-set is used. Average Line is the BC Ministry of Forests’ standard method 
for compiling all cruises in all regions of the Province.  

The Average Line method of reporting uses all plots within a given timber type to summarize 
the area of that type throughout all blocks and all harvest methods in the compilation. This will 
result in a matching of volumes between the sum of the individual block or harvest method units 
and the Cutting Permit and All Harvest Method reports.  

The Block Method only uses plots that fall within the boundaries of the block/harvest method 
unit to summarize that unit.  The Cutting Permit and All Harvest Method reports are always 
based on all plots in the cruise.  This usually results in a discrepancy between the total volumes 
of the cutting permit based on the sum of the individual blocks and the total volume reported in 
the total Cutting Permit report or the All Harvesting Method report.  The total volume of 
each harvest method must be prorated to match the All Harvest Methods report’s total volume 
for appraisal purposes.   

Block method compilations are no longer permitted for MoF appraisal cruises, as of April 1, 2003.  
For mixed block utilization situations or if block reductions are required then assign unique types 
to each block.  The program permits compiling with the block method for non-appraisal cruises. 

  



CruiseComp User Manual   

 Industrial Forestry Service Ltd 29 
 

 
Average Line Method: 

 
All plots (1,2,3,7,8,9) from Type 1 are used to calculate an average value. That 

value is then multiplied by the total area of the type in each block. 

 

Type in Block Method: 

 
 Only plots in a specific type and block (eg plots 1, 2, & 3 in blk 1 type 1) are used to calculate an average 

value. That value is then multiplied by the area of Type 1 within Block 1. 

 

Figure 21 - Graphical Description of Average Line and Block Compilation Methods 

 

 4.2.12  Compile Short Trees 

Used only when running a Not For Appraisal Purposes compilation. Normally, a short tree that 
cannot compile at least one log greater or equal to the minimum merch length is removed from 
the compilation for volume and is compiled as a useless tree. When this option is selected, trees 
that do not have at least one log greater than the minimum merch length, but have one that is 
greater than the minimum log length will be compiled and included in the net volume. 

The checkbox is left unchecked for Appraisal Purposes. 

 4.2.13  100% Cruise 

The 100% Cruise option is used for 100% tally cruises that cover areas greater than 9.9 
hectares. The plot size or sweep does not need to be entered in the plot card header section (card 
type 2), but the areas must be entered in the appropriate locations on the type, block, and 
harvest method tabs. 

For 100% tally areas less than 10.0 ha, run a regular compilation with a single fixed area plot for 
each block, with the plot size set to match the block size. 

 4.2.14  Last Log Options 

 Append it to 2nd to the Last Log – this is the default selection.  If the last log is 
shorter than the minimum log length permitted, the last log will be appended to the 
second to last log. 
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 Compile It Separately – only for use with non-appraisal compilations.  If the last 
log is shorter than the minimum log length permitted, the last log will be compiled as 
a separate log. 

 Throw It Away – only for use with non-appraisal compilations.  If the last log is 
shorter than the minimum log length permitted, the last log will be thrown out and not 
compiled. 

Please be aware that under certain circumstances, a grade validation warning may occur when 
the Append it to 2nd to the Last Log option is selected. In the example below (fig 21) the 
second to last log (log 2) is an I grade for 10 meters, and the last log (log 3) is a Y grade for 
99. When the compilation is run, it calculates the last log to be about 2.8m, which is too short 
for a Y grade. Log 3 then gets added to log 2.  The validation warning shows log 2 as the last 
log, an I grade with a non-preferred log length of 12.8 m and a 15 cm top. This would normally 
be an error because the minimum top size for an I log is 38 cm, but because the Append it to 
2nd to the Last Log option was selected it is accepted.  

 
Figure 22  - Grade warning example 

 4.2.15  Compilation Standard Advanced Button 

 Use Point Count/Measure Tree Sampling Method is used for compiling plots that 
contain a mix of measure and count trees. Commonly known as a Big BAF cruising, 
count trees are selected by a normal sized BAF and then the measure trees are selected 
using a significantly larger BAF. To activate this option, select the check box. 

Important!: The little BAF is the one recorded on each plot. The Big BAF is only used to select which 
trees will be measured. It does not need to be recorded and is not used for compilation purposes. 

 Apply Measure Tree Selection Weighting is used in the Big BAF sampling module.  
If the measure tree selection process is not weighted equally among all the plots, this 
checkbox can be picked.  It would not be normally chosen when using a Big BAF.  If 
the sampler decides to pick a certain number of measure trees per plot (say 1 per 
plot), the compiler would choose this checkbox.  It properly weights the measure trees.  
(This option is not currently available) 
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 Apply Volume Correction is used by IFS for custom compilations. 

 Utilization based on Diameter Outside Bark at Stump Height is used by IFS for 
custom compilations. 

 Split Spruce High Grade Volume as Required by MOF in Coastal Compilations 
allows the option to compile using percentages from the MoF spruce High Grade table 
to split a portion of any cruiser called F and G grades into D and E grades respectively. 
This is necessary due to log characteristics that are not easily visible to the cruiser, 
such as ring density and the presence of wavy grain. D and E grades must have a 
minimum of 12 rings/2cm, while F and G grades must have a minimum of 6 rings/2cm. 
Please refer to section 10.4.7 of the MoF Scaling Manual for further details. 

 Separate BG from other B. This checkbox allows the user to easily combine or 
separate grand fir from other balsam species when compiling. It is available “For 
Appraisal Purposes” and “Not For Appraisal Purposes” 

 4.3  Areas 

CruiseComp has made significant changes in the way areas are now entered into the program. 
This upgrade allows for compiling and reporting blocks by harvest method, when that option is 
selected. 

The Type, Block & Harvest Method area tabs are combined into one Areas tab. There are two 
options to view and input areas, separate or combined block and harvest method areas. They 
are selected by clicking one of the radio buttons at the top of the tab. 

 4.3.1  Separate Block, Harvest Method Areas View 

The Separate Block, Harvest Method Areas option separates input areas into block areas 
and harvest method areas. The areas for both are broken down by type and treatment unit. This 
option is the closest to resembling the original three tabs.  

 

 

 

 

 

 

Viewing Options 

Block Areas Harvest Method 
Areas 
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Figure 23 - Map Area Statement - Areas Card: Separate Block, Harvest Method Areas 

 

 4.3.2  Combined Block & Harvest Method Areas View 

The Combined Block & Harvest Method Areas option combines all the area inputs into one 
sheet. It requires a bit more care to complete, but it will allow compilations to produce Block 
by Harvest Method reports. 

 
Figure 24 - Map Area Statement – Areas Card: Combined Block & Harvest Method Areas 

Each row represents a unique combination Type/Block/TU/Method. There must be no 
duplication of Type/Block/TU/Method combinations. 

When all the areas are entered, the sum must equal the total net merchantable area within the 
CP. Using the Show totals here by: check boxes allow the user to review the totals by Type, 
Block, TU, and/or Harvest Method. This will help ensure there are no input errors. 

 4.3.3  Working with Files From Older Versions Of CruiseComp 

When opening a file that was created and compiled with an earlier version of CruiseComp, both 
views will show the same area information. Each line in the combined view is linked to its 
corresponding line in the separated view. Any edit changes in one view will be reflected in the 
other view.  

 
Figure 25 – Comparison of the Combined and Separated Views 

  

Left click here to start 
entering new data or right 
click to paste data from a 

spreadsheet 
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The user will need to break down the block areas by harvest method, in order to run Block by 
Harvest Method compilations. The harvest method area for each Type/Block/TU combination 
is entered on the input line. When each line is completed CruiseComp automatically moves it 
down into the white area. The yellow shaded lines indicate areas that still need to be split by 
harvest method. 

 

 
Figure 26 – Locked Separate Block, Harvest Method Areas View 

Once a line of Block by Harvest Method information has been entered into the combined view, 
the separated view will be locked and cannot be edited. This indicated by the greyed out areas 
in the Separate Block, Harvest Method Areas view.  

 4.3.4  Working With New Compilation Files 

When working with a new file, the types, blocks, and harvest methods must be set up on 
their respective tabs, before areas can be input into the Areas tab. The types and blocks are 
entered the same way as in previous versions of CruiseComp, except no areas are entered on 
the Types tab. 

Once the types, blocks, and harvest methods have been entered on their respective tabs, 
areas can be entered directly into one of the Areas tables or they can be input into a spreadsheet 
program such as MS Excel then copy/pasted into the table. 

 
Figure 27 - Entering Combined Block & Harvest Method Areas 

New data is entered into the input row at the top of the table. To enter areas directly, simply 
click the cell in the first row under the Type label in the top left hand corner of the table. Key in 
the type number, or use the drop-down and select the type number. Then press the <enter> or 

 Input Row 

Block by 
Harvest 
Method 
Entry 

 

Separate 
Areas Table 
Now Locked 

out 



CruiseComp User Manual   

 Industrial Forestry Service Ltd 34 
 

 
<tab> key. Block, TU and Method are entered the same way. Entering the hectares is just a 
matter of clicking on the Area box, then keying in the area. Be sure to press the <enter> key 
to complete the process. This will move the row of data down into the white area, and ready the 
input row for the next line of data to be entered. 

If an entry error, such as a harvest method that’s not in the compilation, has been made in a 
cell, the cursor will turn blue and be locked into that cell until the error is corrected. The only 
way to get out of that cell is to correct the entry or hit the escape key.  

 
Figure 28 - Incorrect Entry in a Cell 

Before transferring data from a spreadsheet, make sure the data in the spreadsheet is in the 
same order as the fields in the destination table and that there are no non-existent Types, 
Blocks, TUs, or Methods. Highlight the data on the spreadsheet, right click then select copy. 
Move over to the CruiseComp Areas table, and right click the shaded cell under the Type 
label. Then paste the data in.  

 
Figure 29 - Transferring Data From A Spreadsheet to the Areas Tab 

 

 

Incorrect 
Entry 
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Important!: If pasting data from a spreadsheet into an Areas table that contains existing 
data, count the number of rows of data in the table first. If they exceed the number of rows 
being pasted, the extra rows will not be over written. For example, if there are seven rows of 
data in the Areas table and five new records are being pasted in, only the first five rows in the 
table will be over written. The last two rows will remain untouched. 

 4.3.5  Checking, Editing, & Validating 

To help ensure that areas have been entered correctly, click one or more of the Show totals 
here by: check boxes at the top of the tab. This will sum up the hectares by type, block, 
treatment unit, or harvest method. Compare the results with your cruise maps and/or other 
records to make sure everything has been entered correctly. 

The example below shows the summary for each type plus the total net area for the compilation. 
Note the grey lines are locked for editing. Also note the “-“ means all types, or all blocks etc. 

 
Figure 30 – Example of Summary By Type 

  

Sum by 
Type, 

Block, TU 
or Harvest 

Method 

CP Total 
Area 
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On the Separate Blocks, Harvest Methods Areas view CruiseComp checks for discrepancies 
between the Blocks, and Harvest Methods screen. If there is a discrepancy, the total net area 
will show a red shaded background as can be seen in the example below. The user will then have 
to identify where the error is and correct it. 

 
Figure 31 – Example of an area error 

Data in the Areas table can be edited the same way you would edit data in a normal spreadsheet. 
Just click on the cell in the white area & edit the data. 

Rows are easily deleted by clicking in the type cell of the row to be deleted and then pressing 
the <delete> button. 

 4.3.6  Resizing Columns 

The columns can be resized to make viewing easier. Place the mouse cursor on the dividing line 
between two columns along the header row, the same as is done with MS Excel. When the cursor 
changes shape to a double horizontal arrow, left click and hold, then move the cursor to the 
right or left to resize the column on the left. 

 4.3.7  Compiling Block By Harvest Method 

To compile Block by Harvest Method, check off the Use Combined Areas box, which is found 
on the Combined Block & Harvest Method Areas tab. After compiling the data, the user will 
be able to print out a new report called Block by Harvest Method. 

  

Summed areas that 
don’t match produce 

a red shaded total 
areas cell 
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Figure 32 – Check Box for Compiling Block by Harvest Method 

The Block by Harvest Method report summarizes the same information as a normal block 
summary except it reports each individual harvest method within a block. 

 

 4.4  Types 

  
Figure 33 - Map Area Statement - Types Card 

This card contains the type number, and description label.  The type numbers must match the 
values used in the type field on the plot header cards. 

Please note type numbers can now be four digits. 

 4.5  Treatment Units 

A treatment unit is the geographic unit of productive forestland area designated in a prescription 
for a specific silvicultural activity or series of treatments. 

Click Here for 
Block by Harvest 

Method 
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Figure 34 -  Map Area Statement - Treatment Units Card 

This card allows the user to enter a descriptive label for each treatment unit used in the 
compilation.  Areas are entered on the Type, Block Areas, and Harvest Method tabs. 
CruiseComp checks that the sum of the type areas entered in each tab are consistent as part 
of its validation routine. Up to ninety-nine treatment units are allowed (A, B, & C, etc…). 

 4.6  Non-merchantable Areas 

 
Figure 35 - Map Area Statement - Non-merchantable Areas Card 

This card allows the user to enter a descriptive label for each non-merchantable area type being 
used in the compilation.  Up to seven Non-Merchantable areas are allowed (1-7). 

R/W Removed appears automatically on the blocks tab (as requested by the MOF) while the 
descriptions for the others are entered on the Non-merchantable Areas tab before their 
respective areas can be entered on the blocks tab. 
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 4.7  Blocks 

 
Figure 36 - Map Area Statement - Blocks Card 

The Blocks screen is used to record the block number and assign the maturity and descriptive 
labels to each block within the cruise.  The Maturity field (coastal) can be entered either as 
mature (M) or immature (I).  All blocks in the compilation must be listed on the Blocks card.  
The block numbers must match the block field on the plot header cards.  

The R/W Removed field is automatically added into the Blocks tab.  The MOF requires that 
any timbered Right of Way that is not being included in the Cutting Permit be accounted for 
by block. 

 4.8  Harvest Methods 

 
Figure 37 – Map Area Statement - Harvest Methods Card 

Harvest Method data is entered in a manner similar to the Blocks screen.  This screen lists all 
of the harvest method codes used within the area of interest.  The description label for each 
method is printed in the Harvest Method Reports. See Appendix IX for a list of valid harvest 
method codes. 
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 4.9  Height Curve 

Under Ministry of Forests’ guidelines, height curves are no longer allowed for any cruise 
compilation used for appraisal purposes unless approved by the appropriate district office.  This 
means that all appraisal compilations now require 100% of the tree heights to be recorded. 

CruiseComp is capable of producing height diameter curves. However, this option should only be 
used with MoF approval.  If you wish to have CruiseComp calculate a height diameter curve or 
use local curves, you must complete the Height Curve screen. This screen dictates how sample 
tree data will be combined in calculating the regression coefficients. 

 
Figure 38 -  Map Area Statement - Height Curve Card 

A species/type label uniquely identifies each height equation.  The identifying species and type 
are referred to as the Species Used and Type Used.  Height Curves for minor species or 
timber types, for which insufficient or no sample heights were taken, can be calculated using the 
equation generated for another species or timber type if the compilation is Not for Appraisal 
Purposes.   

Note:  The B.C. Ministry of Forests specifies that within an appraisal compilation, each species 
must have 20 sample trees (3 card trees) and must be run using its own height curve.  In other 
words, species cannot be combined together to produce a single height curve.  However, in cases 
where the compilation will not be used for appraisal purposes or permission is given from a 
district office, the above rule can be waived by selecting Not For Appraisal Purposes on the 
Cruise Identity screen. 

The curve description data fields are as follows: 

CALC HT   Calculates height only, also determines whether all of the 
species and types together will be used to calculate one 
curve or if only the sample trees from the Species Used 
and Type Used will be combined to calculate the curve and 
heights.   

 Valid curves are: 

0 or blank - sample trees from all species and types 
listed on this card will be grouped together to 
calculate one equation. 
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1 - sample trees from only the ‘Species Used’ and 
‘Type Used’ will be used to calculate one 
equation. 

SPECIES USED Designates the curve as belonging to this major species.  All 
other species listed on the card will use this equation. Make 
sure the species codes are consistent in the data & the 
height curve table. IE don’t mix H & Hw or C & Cw etc. 

SPECIES 1, 2 or 3 Enter any additional species which are to be grouped with 
the Species Used. Up to three extra species can be entered 
per curve. 

TYPE USED Designates the curve as belonging to this major timber 
type.  All other timber types listed on this record will use 
this equation. Curves are uniquely identified by their 
‘Species Used’ and ‘Type Used’ designation. 

 

The heights calculated by the height curve can be saved by turning on the save generated 
heights switch under file, configuration. The calculated heights are saved in the trees (card 2) 
height fields. Be sure to save a back-up copy of the data set before running this option, in case 
the settings need to be changed and re-run. 

 4.10  Height Equations 

 
Figure 39 -  Map Area Statement - Height Equations Card 

To obtain the equation type and coefficients a, b and c, the user will be required to look up an 
old cruise that has a curve that could be applied to the given species and conditions. 

EQUATION TYPE  Choose one of the six available equation types by clicking on the 
equation type field and selecting an equation. 

COEFFICIENT A, B, C Refer to an old cruise and enter the coefficients. Make sure to enter 
the minus sign if the coefficient has a minus sign. 

SPECIES Enter the species that requires heights. 

TYPE Enter the type that the species resides in. 
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 4.11  Grades (Cruiser Call) 

The Grades tab has all the Cruiser Call features on one tab.   

NOTE:  The call grading module will continue to be run as non-appraisal for 2019.  Since 
January 1, 2007, the MOF has been running a dual system of loss factors and call 
grading to compare systems and develop new coefficients for appraisals for coastal 
compilations. 

 
Figure 40 - Map Area Statement - Grades Card 

Grade Type Select the grading method that will be used to describe a log's quality and 
size.  Options include: 

   1 – MoF Computerized Grades (default) 

  4 – Cruiser Called Alpha Grades  

  5 – Cruiser Called Numeric Grades 

  6 – User Defined Grades  

Apply Taper Correction Factor  

Use only for Coastal Call Grade Net Factoring compilations for appraisals.  When the checkbox 
is selected, the program adjusts the gross volume by applying a factor by species, maturity and 
tree condition.  The taper correction was developed to adjust the taper difference found between 
Kozak’s 1988 taper coefficients and the NVAF sampling process.  These factors were developed 
for the coastal region only. 

Apply Net Volume Adjustment Factor (NVAF) 

Use only for Coastal Call Grade Net Factoring compilations for appraisals.  When the checkbox 
is selected, the program adjusts the net volume by applying a factor by species, maturity and 
tree condition.  The NVAF was developed to correct the cruisers’ net factor estimate.  These 
factors were developed for the coastal region only. 

Use Newton’s Volume Equation 

Use only for interior and coastal algorithm grade compilations.  

Use Smalian’s Volume Equation 

Use only for coastal call grade compilations. 
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Net Volume Deduction   

Check the loss types you want to calculate and deduct from the net volume.  For all appraisal 
compilations, Breakage, Decay and Waste must be checked to enable the radio buttons. 

Breakage  

Use Coastal CGNF Lookup Table – used for coastal CGNF appraisal cruises 

Use MOF (1976) Breakage Table – used for non-CGNF appraisal cruises 

Use Global Breakage Table – available for non-appraisal cruises  

Decay 

Use Cruiser Call Net Factors – used for coastal CGNF appraisal cruises 

Use Decay Lookup Table – used for non-CGNF appraisal cruises 

Waste 

Based on Cruiser Called Z Grades – used for coastal CGNF appraisal cruises 

Use Waste Lookup Table – used for non-CGNF appraisal cruises 

Grade Details button 

 

 
Figure 41 Grade Details screen 

Cut Variable Logs to Standard Length 

Only for NON-appraisal compilations.  The compiler will convert logs from variable length to fixed 
lengths based on the standard log length. 

Compile Useless Timber 

Only available for Cruiser Called compilations.  This allows the user to compile merchantable 
wood in otherwise useless trees. 

Always Use MOF Log Volume Rules 

Only for NON-appraisal compilations.  Some clients have asked that we compile their internal 
non-appraisal call grading cruises using the MOF logic for calculating volume.  This checkbox 
reconciles the gross volumes when compiling the older MOF way with the call grades. 

Use Tally Tree’s Live/Dead attribute instead of Tree Class 

Only for Coastal CGNF appraisal compilations.  Instead of using tree classes 1-9, the user must 
compile all trees using (L)ive or (D)ead tree attributes found in the Trees (2 card). 
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Use Tally Tree’s Maturity Attribute instead of Age in Tens and Tree Class 

Only for Coastal CGNF appraisal compilations.  Instead of using tree classes 1-9 and age in tens, 
the maturity field will be used.  The user must compile all trees using the (M)ature or (S)econd 
Growth attributes found in the Trees (2 card). 

Grades Table button 

 
Figure 42 Grades – Grades Table screen 

This section allows the user to enter diameter classes by grade.  Ensure that the full range of 
diameters is covered so that no logs are missed in the reports.  The detailed log grade summary 
will report these diameter class breakdowns by species and grade.  Please note each grade can 
have its own diameter classes.  Also, none of the grades requires diameter class breakdowns. 

Dollar Values button 

 
Figure 43 Grades – Grade Value screen 

The Dollar Values…. button allows the user to enter in the log prices by species, grade, 
diameter class and log length.  Most people will use species and grade only.  Please note that 
there are no reports available for this feature.   When the program compiles the dataset, the 
output is compiled and saved in the cco file for later analysis. 
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Custom Validation/Validation Rules 

 
Figure 44 Grades – Grade Validation screen 

Selecting the Custom Validation checkbox activates the user defined parameters inside the 
Validation Rules button. This section is used for internal data checks for company specific 
requirements. To look for the custom validation results, go to the Custom Grade Errors tab on 
the right of the Validation Errors message screen. Results are shown after the data has been 
validated. 

Please note that the Coastal Appraisal Alpha Grades are validated using a separate process. 

Coastal Call Grading/Net Factoring Template 

The following 2 screens demonstrate how a coastal call grading net factoring compilation needs 
to be setup.  Both the compilation standard and the grades tab will require changes from the 
MOF Loss Factor settings.  Please note:  The Presets found on the Project Identity screen 
allows the user to set the default values for the selected compilation type. 

Compilation Standard: 

 
Figure 45 Example of a Standard Coastal CGNF Compilation 
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Grades: 

 
Figure 46 Example of the Grades screen for Coastal CGNF 

Details: 

 

 
Figure 47 Example of Grade Details screen for Coastal CGNF 
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 4.12  Percent Reduction 

The Percent Reduction option allows the user to reduce the volume and stems per hectare 
selected for harvest, for specified portions of a cruise.  Normally this reduction is used for 
selective cutting or proposed thinning operations. 

 

 
Figure 48 - Map Area Statement - Percent Reduction Card 

Percent reduction factors are entered on the Percent Reduction Card to the nearest 1%. To 
reduce the volumes and stems per hectare by 10% from the total cutting permit volume, enter 
a value of 10. This will result in the reports showing the amount being cut as 90% of the original 
total volume.  To make a 100% volume reduction of a given DBH class, enter a value of 100. 

Percent reduction factors are assigned by diameter class and more specifically by the following 
attributes: 

Spec Species designation - The value entered must be a valid species code for 
a species that exists in the compilation. If it is left blank the reduction is 
applied to all species in the compilation. 

Type Timber type - If a valid type number is entered, then the percent reduction 
factors only apply to that type. If this column is left blank, then the percent 
reduction factors are applied to all types. 

RG/TC Risk group/tree class – Attribute grouping to which the reduction factors 
will apply. If this column is left blank, then the factors are applied to all risk 
group/tree classes. In Fig. 39 all live Fd will be reserved from cutting. 

Use one of the following values: 

Risk Groups: 

A - risk group 0 (not used anymore) 

B - risk group 1 (tree class 1, 2, 5, & 8) 

C - risk group 2 (tree class 1, 2, 5, & 8) 

D - risk group 3 (tree class 1, 2, 5, & 8) 
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L - all live trees (tree class 1, 2, 5, & 8) 

R - all dead potential trees (tree class 3, 7, & 9) 

Tree Classes: 

1 - tree class 1 6 - tree class 6 

2 - tree class 2 7 - tree class 7 

3 - tree class 3 8 - tree class 8 

4 - tree class 4 9 - tree class 9 

5 - tree class 5  

TU Treatment unit – The treatment grouping to which the reduction factors 
will be applied to. If this column is left blank, then the reduction factors are 
applied to all treatment units.  The only valid entries for this column, are the 
actual treatment unit codes (A, B, C, D, etc). In Fig. 39 all S trees in 
Treatment Unit B will be reserved. 

Block This field allows percent reduction factors to be applied to individual 
blocks. Percent reduction cannot be applied on a block by block basis if 
the average line calculation method is used. If this is the case, assign a 
treatment unit to the block in question and then apply the percent 
reduction to that treatment unit. 

Damage Damage codes are used to exclude trees from reductions. If a valid damage 
code is entered in the table, all affected trees will be cut, regardless of what 
reductions have been entered on other lines in the table. The damage codes 
must be entered on a separate line from any reduction specifications. As an 
example, in Fig. 48 all trees with root rot codes will be cut, all Pl trees with 
insect damage codes will be cut, and all non-insect damaged Pl will be 
reserved from cutting. 

Valid damage codes are: 

  I = Insect damage 

  B = Blowdown 

  F = Fire damage 

  R = Root Rot damage  

Once all the percent reduction factors have been entered, the compilation can be run with 
or without them by selecting the No Percent Reduction, Apply Percent Reduction 
option, or the Leave Tree Report option located on the Percent Reduction Tab.  

In order to see what timber will be reserved in a percent reduction compilation, select the 
Leave Tree Report option. 

Reduction factors can be saved in a *.pr file and used in subsequent compilations. Once the 
percent reduction factors have been entered, click on the save button on the percent reduction 
page, and follow the prompts to save the file. To recall a previously saved file, click on the load 
button and follow the prompts.



CruiseComp User Manual   

 Industrial Forestry Service Ltd 49 
 

 

 5  CRUISE PLOT CARDS  
 

 

 

 

 
Figure 49 -  Cruise Plot Card 

When one of the card tabs is highlighted (note the dashed line around Header (card 9) in figure 
40), function keys can be used to toggle between the Header (Card 9 = F9), Trees (Card 2 = 
F2), Sample Trees (Card 3 = F3) and Growth Rate (Card 5 = F5) screens respectively. 

Cruise plots can be sorted by selecting the Block, Type, Strip, Plot or Method button on the 
left side of the screen. Plots can only be sorted by one attribute at a time. 

  

Plot Sorting Buttons 
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 5.1  Header Card 

Fields included on the Header Card correspond directly to the header card fields on the Cruise 
Tally Sheet: 

The plot attributes displayed on the header card are for the plot selected in the plot listing on 
the left. 

 

 
Figure 50 -  Header Card (Card 9) 

Block  Block number 

Strip Strip number 

Plot Plot number 

O/C Original/Check cruise identification: 

O = original measurements 

C = check cruise measurements 

Type Enter the number given to the timber type in which this plot is 
located. (Maximum of three digits) 

 

Age in Enter the average total age in tens of co-dominants of the 
10’s  first major species in the plot.  Valid class age codes are: 

 Age Class Age Class 
 21-30 03 91-100 10 
 31-40 04 101-110 11 
 41-50 05 111-120 12  
 51-60 06 121-130 13 
 61-70 07 131-140 14 
 71-80 08 141-250 15 to 25 
 81-90 09 251+ 26 

Height Enter the height to the nearest meter for the dominant and co-
dominant trees of the major species in the plot.  This only applies 
to the plot area and is based on sample tree heights taken on the 
plot. 
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Plot  Valid plot types are: 
Type * or M - measure plot 

        C - count plot   

Ha Enter the plot size in hectares for circular or rectangular shaped 
fixed plots.  Leave blank if prism plots are used. 

BAF Basal Area Factor (BAF).  Enter the BAF for the main stand element 
being sampled.  Must be entered to three decimal places. Leave 
blank if fixed area plots are used. 

Prism The three valid prism sweep codes are: 
Sweep F - Full (360o plot); All trees 
 H - Half (360o plot); Every second tree 
 B - Border (180o plot); all trees in measured ½ of plot 

 Leave blank if fixed area plots are used 

DBH The minimum dbh to which the trees in the plot are  
Limit measured. 

Sub Fields in the sub-plot area should be entered in the same  
Plot manner as corresponding fields in the Main Plot area. 

Harvest   The harvesting method, which will be used.  See Appendix IX for 
Method    the valid codes 

Slope % Enter the most severe slope measurement to a point 15 meters 
horizontal distance from plot centre. 

Date Date that the cruise was carried out. (yymm) 

 5.2  Trees Card 

The Trees Card contains the individual tree details including quality and size measurements for 
each tree within the plot. 

 
Figure 51 -  Tree Card (Card 2) 

Tree Number The number assigned to the individual trees in the cruise plot. 

Height The height, to the nearest 0.1 meters, of each tree within the plot. 

Species Enter the appropriate commercial species symbol for each tree within 
the plot. 

DBH Enter the diameter, in centimeters, at breast height (dbh) of each tree 
within the plot. 
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Tree Class Enter the appropriate numerical tree class code: 

1 – Residual 6 – Live Useless 

2 – Suspect 7 – Vet. Dead Potential 

3 – Dead Potential 8 – Immature 

4 – Dead Useless 9 – Immature Dead Potential 

5 – Veteran  

  

Pathological  Enter the pathological remarks, using the appropriate  
Remarks  numerical codes (refer to the MoF Cruising Manual), for each tree within 

the plot. 

Quality   Enter the quality information, using the appropriate quality codes, 
Remarks   collected on all trees within the plot. 

Selective Enter the appropriate code in the Selective Logging column. 
Cutting Valid codes are: 

L – leave tree 
C – cut tree 

Damage  Enter the appropriate damage codes in the root rot (RR), insect (IN), 
fire (FI) and/or blowdown (BD) columns. 

Total Age Enter total age.  The 3 card is still required if trying to calculate the site 
index.  This field is used mainly to create age classes in the forest 
inventory module. 

CC Enter the Crown Class (CC) by number code for each tree sample within 
the plot.  Valid number codes are: 

1 - Dominant 

2 - Co-dominant 

3 - Intermediate 

4 - Suppressed 

Live Crown Enter the Live Crown in %. (0-100%)   This field is not required. 

CT  Count Tree.  Enter “T” for true if the tree is a count tree.  This field is 
used in the Big BAF module to indicate that a tree is a count tree.  
Sometimes tree information is entered into a tree record that contains 
more than tree# and species.  If this occurs, the program is not sure if 
the tree is a measure tree missing information, or a count tree.  
Therefore, if a “T” is entered into this field when some measure 
information is present, the program will understand the tree is to be 
compiled as a count plot.   

L/D  Live/Dead.  Every tree must have either a (L)ive or (D)ead attribute 
entered when compiling using coastal call grading net factoring.   

M/S  Mature/Second Growth.  Every tree must have either a 
(M)ature or (S)econd Growth attribute entered when using 
coastal call grading net factoring.  
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 5.3  Sample Tree Card 

Enter the Tree Number, Height, Species, DBH, Crown Class, Age and Selective Cutting 
attributes for each sample tree in the plot. 

 
Figure 52 - Sample Tree Card (Card 3) 

 

Tree Number The tree number assigned to the tree in the cruise plot. 

Height The sample tree height, to the nearest 0.1 meters. 

Species Enter the appropriate commercial species symbol for each 
sample tree within the plot. 

DBH Enter the diameter, in centimeters, at breast height (dbh) 
for each sample tree within the plot. 

CC Enter the Crown Class (CC) by number code for each tree 
sample within the plot.  Valid number codes are: 

1 - Dominant 

2 - Co-dominant 

3 - Intermediate 

4 - Suppressed  

Age Enter the total age for each bored tree in the cruise plot. 

SE Enter the appropriate code in the Selective Logging 
column for each sample tree in the plot.  

Valid codes are: 

L – leave tree 

C – cut tree 

Counted Age Enter the counted age for each bored tree in the sample  
 plot. 

Corrected Years Enter the boring height correction obtained from the 
appropriate Site Index Table. 

Bored Height Enter height at which the tree was bored. Typically 1.3m 
above high-side. 

 

Important!: The tree number, height, Species, & DBH must match with the corresponding 
tree in card type 2, otherwise a validation error will occur when the data is compiled. 
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 5.4  Growth Rates Card 

Enter the Tree Number, Rings Last 2.5 cm, and Ten Year Growth fields for each tree listed 
on the Growth Rates Card (card 5). 

 

 
Figure 53 -  Growth Rates Card (Card 5) 

Tree Number The number assigned to the corresponding tree on the Trees 
card. 

Rings Last Enter the number of rings, counting from the cambium  

2.5 cm toward the pith, as entered on card 9 of the field cruise. 

Ten Year Enter the measurement from the cambium toward the pith  
Growth (to the nearest 0.1 cm), as entered on card 9 of the field 

cruise. 

 5.5  Grades Card (Cruiser Call) 

The Cruiser Call module includes two additional plot cards in the interface.  Due to space 
constraints, the tree card is split up so that standard appraisal information is on one card and 
the Cruiser Call grades are on another.  There is also an additional User Grades card for 
customized cruiser call grades. 

 
Figure 54 -  Grades Card (Card 2A) 

Enter the log grade, log length, and net factor by log for each tree.   

1G, 2G, 3G,…12G – Available log grades to enter.  (Grade for log 1, 2, 3, etc) 

1L, 2L, 3L,…12L – Available log lengths to enter.  (Log length for log 1,2,3, etc). 

1F, 2F, 3F,…12F – Available log net factors to enter.  (Net factors for log 1,2,3,etc) 

 

Alpha Grades – B,C,D,E,F,G,H,I,J,K,L,M,N,U,X,Y,Z.  (Coastal call grade standard) 

User Grades – any codes defined by the user can be entered into the user grades card.   

 

Log Lengths – 1-99m.  The 99 length can only be called for the last log in the tree and the 
compiler will compile standard log lengths up to the merchantable height of the tree. 
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Net Factors – 0-100%.  The net factor is the estimated sound volume for each log in the tree. 
The Net Factor % is entered as a whole number. 100% net factor (ie no decay) is entered as 
“–“.    

 5.6  User Grades Card (Cruiser Call) 

It can be handy if not valuable to cruise with customized user grades at the same time as tallying 
Coastal CGNF grades.  

The User Grades card was created to allow compiling with user specified internal sort grades. Both 
User and CGNF grade types can be stored for each plot at the same time. 

 

 
Figure 55 - User Grades Card  

The User Grades card has the same fields as the Grades (Card 2a)card. The grades, log lengths 
and net factors are entered the same way as the CGNF grades, then validated using custom 
validation rules entered on the Grades tab of the Map Area Statement.  
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 6  REPORTS 

 6.1  Volume Summary Reports 

The Volume Summary Reports, which include the Cutting Permit, Block and Type 
Summary, are required by the Ministry of Forests for cutting permit applications.  For a Coastal 
FIZ, volumes are summarized by log grade.  For an Interior FIZ, volumes are summarized by 
lumber recovery factors (LRF’s).  The volume summary reports provide detailed information on 
the gross and net merchantable volume grouped by species.  It also describes the log grades 
(Coastal) or LRF’s (Interior) and the decay, waste and breakage levels. 

 6.1.1  Cutting Permit Summary Report 

The Cutting Permit Summary Report is required by the Ministry of Forests for all cutting 
permit applications.  The cutting permit volumes are computed using all the plots, stratified by 
type and the merchantable area within the cutting permit. 

 6.1.2  Block Summary Report 

The Block Summary Report is similar to the Cutting Permit Summary Report.  The type of 
report produced is dependent on whether the compilation is run as an Average Line or Block 
Method compilation.  For a Block Method compilation, the separate block reports that are 
generated use only the plots that fall within the type and block combination.  For an Average 
Line compilation, the separate block reports that are generated use all the plots within the entire 
type. The block summary reports also include summaries by treatment unit. 

 6.1.3  Block by Harvest Method Summary Report 

The Block by Harvest Method Summary Report is similar to the Block Summary Report 
using the Block Method compilation except the plots are further stratified by harvest method. 
The volumes are also reported by each harvest method within the block. In order to generate a 
Block by Harvest Method Summary report the Areas table must be set to Combined Block 
& Harvest Areas. 

 6.1.4  Type Summary Report 

The Type Summary Report is identical in format to the block and cutting permit summaries.  
Each type report that is generated uses only the plots that land within that type. 

 6.1.5  Damage and Root Rot Summary Report by 
Cutting Permit, Block, and Type 

The Damage Summary Reports provide gross and net volumes based on the damage 
present within a Cutting Permit, Block and Type. 

 6.1.6  Extended Cutting Permit, Type and Block 
Summary Reports 

The Extended Summary Reports are essentially the same as the Cutting Permit, Type and 
Block Summary reports except they contain damage information for Fire, Blowdown and 
Insects. 

 6.2  Cruise Statistics Reports 

Cruise Statistic Reports include the, Volume Statistical Analysis, Basal Area Statistical 
Analysis, and Net VBAR Statistical Analysis reports. Each report shows the sampling error, 
standard deviation and coefficient of variation for the cutting permit compilation.  
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 6.2.1  Volume Statistical Analysis 

The Volume Statistical Analysis report provides a breakdown of the net volume (m3/ha), 
proportional volume, number of trees, standard deviation, coefficient of variation and sampling 
error for every type in the compilation and for the compilation in total. 

 6.2.2  Basal Area Statistical Analysis 

The Basal Area Statistical Analysis report provides a breakdown of the basal area (m2/ha), 
proportional basal area, standard deviation, coefficient of variation and sampling error for every 
type in the compilation and for the compilation in total. 

 6.2.3  Net VBAR Statistical Analysis 

The Net VBAR Statistical Analysis is used for measure/count, & Big BAF compilations. It 
provides a breakdown of the Net VBAR (m3/m2), proportional VBAR, standard deviation, 
coefficient of variation and sampling error for every type in the compilation and for the 
compilation in total. 

 6.3  Stand, Stock and Basal Area Reports 

CruiseComp produces Stand (stems/ha), Stock (M3/ha) and Basal Area(M2/ha) tables 
for the cutting permit, blocks and type compilations.  Each of the reports provides a summary 
by DBH class and species in addition to the amount of dead potential, dead useless and live 
useless timber within the block, type or cutting permit. The Stand, Stock and Basal Area tables 
also provide the information by individual treatment units. 

 6.3.1  Cutting Permit Stand, Stock and Basal Area 
Report 

The Cutting Permit Stand, Stock and Basal Area report provides a per hectare summary for 
the entire cutting permit by DBH class and species. 

 6.3.2  Block Stand, Stock and Basal Area Report 

The Block Stand, Stock and Basal Area report provides a per hectare summary for each block 
in the cutting permit by DBH class and species. 

 6.3.3  Type Stand, Stock and Basal Area Report 

The Type Stand, Stock and Basal Area report provides a per hectare summary for each type 
in the cutting permit by DBH class and species. 

 6.3.4  Damage and Root Rot Reports by CP, Block, and 
Type 

The Damage and Root Rot report provides stand and stock summaries for damaged timber in 
the treatment unit, by species and damage category. 

 6.3.5  Extended Type Stand and Stock Report 

This report provides detailed information by type, treatment unit and species.  It gives an 
analysis of height, gross volume per tree, net volume per tree and stems per hectare specified 
by diameter class.  This report is primarily used for checking percent reduction compilations. 

 6.4  Plot Summary Reports 

The Plot Summary Reports include stems per hectare, average DBH and gross and net 
volumes per hectare by species calculations.  Also listed is the Loss Factor Table number used 
for the decay, waste and breakage factors. 

The four plot summary reports are: 
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 6.4.1  Plot Summary 

The volumes listed in the Plot Summary Report provide a breakdown of volume (m3) for 
individual sample plots by species. 

 6.4.2  Plot Summary (VBAR) 

The Plot Summary (VBAR) report is the same as the Plot Summary Report except that it 
provides a breakdown of volume (m3) for individual sample plots by species using VBAR 
calculations. This allows CruiseComp to report volumes for count or Big BAF plots. 

 6.4.3  Plot Frequency Report 

The Plot Frequency report shows the number of plots within each type and block combination 
of the cutting permit.  It also shows the relative ha/plot for the entire cutting permit. 

 6.4.4  Volumes by Plot 

The Volume by Plot report shows the volumes of individual species by plot, sorted by type. 

 6.4.5  Plot Listing Report 

The Plot Listing Report lists all Map Area Statement card and tree data. The report also lists 
all 9 Map Area Statement cards and all 3 MoF Cruise Tally Sheet cards (FS 205) separately. 

 6.4.6  Extended Plot Species Report 

The Extended Plot Species Report provides plot attributes as well as a breakdown of 
volumes, damage, decay and interior appraisal information by species. 

 6.5  Harvest Method Reports 

The Harvest Method reports list data that is similar in format to the Block and Cruise 
Summary Reports.  It also includes information on damage (fire, insect or blow-down), net 
second growth and slope. The volumes for harvest methods are calculated using only the plots 
that occur within the specified harvest method area. 

The three harvest method reports are: 

 6.5.1  Appraisal Summary Report 

The Appraisal Summary report provides a breakdown of grades and volumes by species 
contained in the All Method Summary, as well as particulars for each individual harvest 
method.  This report also contains cutting authority information. The Appraisal Summary 
Report is mandatory for the Ministry of Forests as of April 1, 2003. 

 6.5.2  All Methods Summary Report 

The All Methods Harvest Summary Report provides information similar to the Cutting 
Permit Summary Report by showing detailed information on the gross and net merchantable 
volume broken down by species for the combination of all harvest methods. 

 6.5.3  Harvest Methods Summary Report 

The Harvest Methods Summary Report provides the same information as the All Methods 
Report, however it is divided into separate harvest methods by treatment unit. 

 6.6  Field Data and Slope Averages Report 

The Field Data and Slope Averages Report lists the slope of each plot, and also gives the 
average slopes of the Cutting Permit and Harvest Method. 
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 6.7  Volume and Lumber Recovery Information (LRF) Reports 

The Volume and Lumber Recovery Information Reports summarize the volume and lumber 
recovery information by species and diameter class by CP, Block or Type.  These reports are 
required for Interior compilations and are generated only when Type of Compilation is set to 
Interior in the Compilation Standard tab. 

 6.8  Height Curves Report 

The Height Curves Report provides a detailed description of the height curves used in the 
compilation for the species and types specified in the height curve set up. 

 6.9  Tree Report 

The Tree Report is a single stem volume analysis that produces a tree-by-tree report 
showing all of the information generated.   

Note:  If there are a large number of trees in the cruise, this report may require a large amount 
of paper when printing. 

 6.10  Percent Reductions Applied Report 

The Percent Reduction Report is essentially a print screen of the Percent Reduction tab 
located in the Map Area Statement. 

 6.11  Partial Cut Percent 

The Partial Cut Percent reports the Net Volume and Reduced Net Volume, and the Partial 
Cut Percent by type and treatment unit. This report can be used to determine if a harvest 
method should be considered clearcut or selective cut. 

 6.12  Double Sampling Factors 

The Double Sampling report shows the double sampling ratios by species, type, block and 
harvest method. 

 6.13  Map Area Statement 

The Map Area Statement Report lists all details on the Map Area Statement cards A-G. 

 6.14  Project Description Report 

The Project Description report provides a summary of information describing the cruise 
compilation.  It identifies such information as licensee name, license number, cutting permit 
number, utilization specifications and area description by type, treatment unit, block and harvest 
method. 

 6.15  Logs 

The Log Distribution Reports provide total volumes and volumes by species based on top 
diameter for a cutting permit, block or type. 

 6.15.1  Log Report  

The Log Report provides log attributes, by type, for every tree within each plot in the cruise.   

 6.15.2  Log Distribution by Cutting Permit, Block, 
and Type 

The Log Distribution reports provide the number of Logs/ha, Net Vol/ha, Net Vol/Log, & 
Lineal Meter/ha by diameter class. 
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 6.15.3  Detailed Log Grade Table by Cutting Permit, 

Block, and Type 

The Detailed Log Grade Table Report provides net volume & percent in each grade/sort for 
each species by treatment unit. 

 6.15.4  Log Analysis by Cutting Permit, Block & Type 

The Log Analysis report provides log attributes by treatment unit, for each species, by user 
defined diameter classes. 
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 7  BURN SIMULATOR 

 7.1  Background 

In the fall of 2017 the MoF (MOFLNRO&RD) issued a directive and guidelines for using 
comparative cruises for Interior fire damaged timber stands, in order to expedite 
harvesting before timber values deteriorate further.  

The Burn Simulator modifies the comparative cruise data to simulate the burn conditions in a 
harvest stand. 

Refer to the Provincial Cruising Manual, the Interior Appraisal Manual and the “Interim 
Guidance on Comparative Cruising Fire Damaged Stands” (dated November 15, 2017) 
for information on how to make the required estimates. 

 7.2  Preparing for a Burn Simulation 

Prior to using the Burn Simulator, the user must: 

• Select a previously cruised stand that best represents the pre-fire damaged harvest stand 
conditions. The comparison stand must meet MoF criteria and be approved by the MoF. 

• Assess the extent of the fire damage in the harvest stand. The total area of the harvest 
stand must be broken down into 4 fire damage intensity categories, no-damage, heavy, 
moderate, and light damage.  

• Determine the percentage of each tree species group with each fire damage code in each of 
the intensity categories. 

The comparison cruise dataset will be loaded with the field estimates from the fire damaged 
stand and compiled to come up with an estimated net merchantable volume for the fire 
damaged stand. 

 7.3  Species Groups 

Currently the MoF combines thick bark species, Douglas-fir and larch in one group, and all the 
other species in the second group. The user can also create customized species groups should 
they want run an in-house burn simulation compilation. 

 7.4  CSV File 

The burn simulator uses a csv file to bring the burn parameters into CruiseComp. A template 
for the csv file called Burn_Simulator_Template.csv can be found in the CruiseComp 
executable folder. Open the file using MicroSoft Excel.  

Important!: Make a working copy of the template and use it to make any 
modifications. 

Do not delete any rows when making modifications. Just update the areas and fire code 
percentages to reflect the conditions of the burn stand.  

 7.5  Burn Intensity Table 

The file contains the Burn Intensity Table, which consists of three sections. The first is the 
Burn Intensity Section. It contains the area in hectares by damage intensity. This table is 
used to determine how many cruise plots are assigned to each damage intensity category. The 
sum of the areas will be imported into the comparison cruise as total merchantable area. 

The second section contains the Fire Damage Code tables. There is one table for each 
species group. Each table is broken down by the percentage of trees that have one of the 
three fire damage codes by intensity. Each intensity category must add up to 100%. 
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Section 2 – Fire Damage Code 
(each row must add up to 100%) 

Refer to section A.6.2 of the MoF Provincial Cruising Manual for Fire Damage Code 
definitions. 

The third section contains the Species Group definitions. Each row has a species that is 
present in the comparison data, and the species group it is assigned to. 

 

 
Figure 56 - Example of a Burn Intensity Table 

Make a working copy of the csv template, saving it in the same folder as the ccp file, and giving it an easily 
identifiable name such as the Tenure and CP. Open the working copy in MS Excel, and input the damage intensity 
areas and the fire code percentages from the fire damaged stand estimates into their respective tables. 

When the tables are complete, save the file. Keep the csv file format by clicking Yes when prompted (see below) 
then close it.  

 
Figure 57 – Saving the CSV file 

 

  

Section 3 - Species Group 
definitions 

Section 1 - Burn Intensity 
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 7.6  User Customized CSV File 

While the user must not delete rows from the template file, they are permitted to make additions to it in order to 
customize it.   

The user can customize the burn simulation with one or more species groups for in-house purposes. Select and copy 
one of the existing tables, and paste it immediately above the Species section in the CSV file. Make sure there is a 
# symbol separating each table/section. Edit the table name to make it unique, and identify what it represents. Edit 
the percentages to reflect the new species group. Finally, add the new table name to each species associated with it 
in the Species section. Please note the table name for each Fire Damage Code table must match exactly with one 
of the table names in the Species section. Also, be aware that the species codes are case sensitive. They must be all 
upper case. (ie Py must be entered as PY). 

 7.7  Loading the CSV File into CruiseComp 

Important!: The simulator will make permanent changes to the data, so it is advisable to make a backup 
copy of the comparison cruise data before running it. This will allow for an easy recovery if an error occurs 
or the user decides to start over. 

Open up the comparative cruise file in CruiseComp. Click on File, then click on Load Burn Parameters... 
Navigate to the recently created csv file, select it and click Open. 

 

  
Figure 58 – Loading the CSV file into CruiseComp 

 

When the parameters have been loaded, click OK when prompted. 
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 7.8  Running a Burn Simulation 

Click on the Simulate Burn command to run the module. Fire codes will be added to the trees and the stand will 
be changed to a single block with a single type and a single treatment unit. The total merchantable area will be 
changed to the harvest stand area, and the plots will all be re-numbered consecutively starting at 1. This is all in 
accordance with MoF requirements. 

  
Figure 59 - Running the Simulate Burn command 

 

When the burn simulation is complete, a prompt will advise the user. Click OK. 

As mentioned above, the burn simulator creates a dataset with one block, one type, and one treatment unit. If the 
user wants to keep one or more blocks, types and/ or treatment units separated, then the burn simulator will have to 
be run on each individually, then merged together afterwards before running the final compilation. 
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Other species 
results 

Fir-Larch results 

 

 7.9  Burn Simulation Report 

A Burn Simulation Results report will pop up showing how the plots were assigned to the damage intensity 
categories and the target and actual percentages of trees given each fire code. 

 

 

 

 

 
Figure 60 - Example of a Burn Simulation Report 

 

In the example above, in the plot results section at the top, plots 1 to 6 (19% of the plots) are classified as unburnt 
so no damage code will be assigned to the trees in those plots.  

Plots 7 to 20 (45.2% of the plots) are classified as heavily burned. According to the Other species table under the 
heavy intensity category there are a total of 56 trees in these plots. The target for damage code A is 50% of the trees, 
the actual calculated percent is 54% (30/56). The target for damage code B is 10% of the trees, and the calculated 
percent is 11% (6/56). The target for damage code C (not visible) is 40% of the trees and the calculated percent is 
36% (20/56). The cycle, starts with the first “Other species” tree in plot 7. Fire Damage Code A is given to the 
first five “Other species” trees, then the next “Other species” tree is given Fire Damage Code B and then the next 
four “Other species” trees are given fire code C. This pattern will repeat until all the “Other species” trees in plots 
7 to 20 have been assigned a fire damage code. The process will be repeated for the moderate and light burn intensity 
areas, and then again for the Fir-Larch trees using its table. 

Click Save to create a text output file that can be viewed later or kept for documentation purposes. 

If the report looks satisfactory then the data can be compiled like a normal cruise. 

Target and actual 
percentage of plots in 

each intensity category 

Plot numbers 
assigned to 

each category 

Number & % of 
other species trees 

by intensity 
category & 

damage code 

Target and actual 
percentage of trees in 

each intensity category 

Plot results 
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 8  STUMP CRUISE 
Creating or opening a stump cruise is covered in Section 3.1.2. 

 

 

Figure 61 - Stump Cruise - Tree Card  

 8.1  Field Procedures 

Since the trees being cruised in a stump cruise no longer exist, the trees card (card 2) field 
procedures differ significantly from a normal cruise. The procedures include: 

1. All stump cruise information should be recorded on the FS 205S tally card. This is a 
Ministry of Forests tally card specifically created for stump cruises. 

2. All stumps should be numbered and recorded from 1-98. If there are greater than 98 
stumps in the area, you can begin numbering again at 1-98. 

3. Stump height replaces tree height. Stump heights must be measured from the high 
side to the nearest centimeter, using no decimals. 

4. The Diameter Stump Inside Bark (DSIB) can be measured in either centimeters 
or in rads. A rad is equal to two centimeters (scaling measurement). The MoF has 
specified that only inside bark measurements be taken. Diameter Outside Bark 
measurements are no longer acceptable for stump cruises. 

5. Only tree classes 1, 2, 5, or 8 are permitted. The valid path indicators are conk in 1, 
scar in 1 or frost crack in 1. There are also no columns for quality remarks or grades. 

6. A minimum of 20 sample trees is required for each major species within the area. The 
representative heights and diameters should be taken from a nearby stand. For minor 
species a minimum of 10 sample trees are required. If it is difficult to find adequate 
sample trees for a minor species, you may combine the sample trees with a similar 
species. 

7. The Age Code must be recorded to determine the correct loss factors. As noted above, 
a tree class of 5 or 8 can be utilized for mature or immature trees. 

8. It is important to ensure that the correct utilization (dbh) has been recorded. For 
example, on private land the owner may require all stems to be compiled, while on 
crown land the dbh utilization may be 17.5 cm. 



CruiseComp User Manual   

 Industrial Forestry Service Ltd 67 

 

 8.2  Procedures 

 8.2.1  Entering Areas 

The area on the Cruise Identity tab must equal the sum of the main plot areas (hectares) 
recorded on the 9 cards. A value of 1.000 ha for each stump cruise block/unit is commonly 
used to avoid any discrepancies. 

 8.2.2  Calculating DBH 

In order to calculate DBH, the following equation is used for each stump diameter measurement. 
The age or maturity of the tree is derived from the tree class and age in tens taken from the 
cruise tally cards. 

 DBH = DSIB +b0 DSIB (2.3-SH) + b1 DSIB In [(SH + 1.0)/2.3] 

Where:  

 DBH =  diameter at 1.3m outside bark (cm) 

 DSIB =  diameter at stump height (SH) inside bark (cm) 

 SH =  stump height from the point of germination (m) 

 b0 b1 =  regression coefficients 

 ln =  natural logarithms 
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The regression coefficients, (b0, b1) are unique to each species, age maturity group and FIZ as 
listed below. 

Table 1. Regression coefficients for calculating stump DBH. 

Species Age FIZ b0 b1 

F M abc 0.192451 0.656977 

F I abc 0.155107 0.564107 

F all d-l 0.189385 0.712098 

C M abc 0.032043 0.585026 

C I abc 0.055116 0.706639 

C all d-l 0.059052 0.655006 

C all a (QCI) 0.0297088 0.404490 

H M abc 0.064571 0.534355 

H I abc 0.077996 0.438284 

H all d-l 0.100771 0.504787 

H all a (QCI) 0.0508525 0.360565 

S M abc 0.021123 0.530663 

S I abc 0.046301 0.580005 

S all d-j 0.065728 0.575037 

S all k-l 0.062808 0.442810 

S All a (QCI) 0.0299746 0.413498 

B all abc 0.057484 0.573054 

B all d-j 0.073625 0.477491 

B all k-l 0.073358 0.431277 

CY all a-l 0.037211 0.460492 

CY all a (QCI) 0.0217802 0.289677 

PW all abc 0.057377 0.561538 

PW all d-l 0.056953 0.449184 

PL all a-j 0.056984 0.374589 

PL all k-l 0.051075 0.337046 

PY all a-l 0.154163 0.638001 

L all a-j 0.190001 0.682016 

L all k-l 0.078977 0.532930 

AC all a-j 0.117130 0.565108 

AC all k-l 0.136074 0.498340 

D all a-l 0.055705 0.374983 

MB all a-l 0.064992 0.421552 

E all a-j 0.070797 0.455765 

E all k-l 0.070901 0.407800 

AT all a-j 0.103886 0.492890 

AT all k-l 0.097907 0.469721 

PA all a-l 0.036171 0.482541 

 



CruiseComp User Manual   

 Industrial Forestry Service Ltd 69 

 
 8.2.3  Calculating Height  

Once the dbh has been calculated, a height curve can be generated using the sample tree data 
recorded from the nearby stand or from another cruise with similar growth patterns. The same 
restrictions apply to a stump cruise as with a normal cruise as far as validations for the height 
curve calculations are concerned. 

 8.2.4  Calculating Volume 

Once the dbh and height values have been calculated for each tree, CruiseComp can now be 
run as per a regular cruise to determine gross and net volumes. All other fields normally shown 
with a regular cruise will be generated. 

 8.2.5  Calculating Grades 

Since the actual tree is missing, and no provision is made on the FS 205S tally card for recording 
quality remarks, CruiseComp will estimate grades using log length and top diameter to give the 
user an idea of what the grades may have been for the area 

 8.3  Reports 

The following is a list of the typical reports required for stump cruise compilations. 

 Cutting Permit Summary - the Block and Type Summary reports may also be 
included if there is more than 1 block or type. 

 Tree report - the tree report shows a tree-by-tree breakdown of the dbh and height 
measurements used. 

 Log report - the log report shows the individual log grades, as well as the top and 
bottom DSIB values. 

 Height Curves - the height curve report is necessary to show the reliability of the 
height curve information. 
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 9  DOUBLE SAMPLING (MEASURE/COUNT) 
The Double Sampling Option within the Compilation Standard page allows the user to 
compile data from a two phase or double sampling cruise. 

In a double sampling cruise, two types of prism samples are recorded in the field: 

1. Measure plots - Prism plots measured to conventional cruising standards. 

2. Count plots - Prism plots in which only the species of each live and dead potential 
tree is recorded. No other measurements are needed in these plots.  

The measured plots are compiled by CruiseComp in the normal manner.  Within the count plots, 
only basal area is calculated.  The statistics generated from the measured plots for each species 
are then adjusted using the ratio of basal area from measured plots to the basal area for all 
plots. 

 

 9.1  Data Entry for Count Only Plots 

In a Double Sampling cruise, the data for measured plots is tallied and entered into the 
computer in the normal manner.  Count plots as a minimum, must contain the tree number and 
a species code. Tree class 4 or 6 trees must not be tallied in count plots. 

The correct plot type (measure = M or blank, & count = C) must be coded for the measures and 
counts in the header (9 card) or the data will not pass the validation process nor will it compile 
correctly. 

Sample tree heights are not recorded in count plots. 
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APPENDIX I - VALIDATION ERRORS 

103 Species (  ) not valid for FIZ (  ). 

 Species [  ] not valid for FIZ [  ]  [VE2: #103].  Species may be a valid code but is not valid in 
the geographical area that is being validated.  Check that the proper FIZ area has been toggled, 
or the species was keyed incorrectly.  

104 Sample tree (  ) has DBH or Height that does not match value in corresponding 2 card 
tree. 

 Sample Tree # [  ] : Sample tree # [   ] has DBH, Height or Species that do not match value 
in corresponding 2 card tree [VE3: #104].  If the same tree number occurs in the 2 and 3 card, 
its height, DBH and species must match.  To edit these errors, use the height from the 3 card and 
the DBH and species from the 2 card as correct.  

105 Attribute (  ) has a value of (  ) which is not in the allowed range of (  ). 

 Attribute CLASS has a value of 0, which is not in the allowed range of (1-9)  [VE2: #105].  
This error occurs when the tree class has been left blank.  

 Attribute “PATH REMARK” has a value of [  ] which is not in the allowed range of (0-7)  [VE2: 
#105].  Check that a valid number was entered in the pathological remarks columns.  

 Attribute SPIRAL GRAIN has a value of [  ] which is not in the allowed range of (0-9)  [VE2: 
#105].  

 Attribute LEAN has a value of [  ] which is not in the allowed range of (0-2)  [VE2: #105]. 

 Attribute SWEEP has a value of [  ] which is not in the allowed range of (0-2)  [VE2: #105]. 

 Attribute LIVE LIMB has a value of [  ] which is not in the allowed range of (1-9)  [VE2: #105].  
Live limb cannot have a 0 or blank value.  Dead potential trees (tree classes 3,7,9) must still have 
a live limb code.  Live limb refers to the log position in 5m sections from the ground where the 
timber quality of the tree changes significantly.  

 Attribute STUB has a value of [  ] which is not in the allowed range of (1-9)  [VE2: #105].  
Stub cannot have a 0 or blank value.  

 Attribute 1ST 5M KNOTS has a value of [  ] which is not in the allowed range of (0-6)  [VE2: 
#105]. 

 Attribute 2ND 5M KNOTS has a value of [  ] which is not in the allowed range of (0-6)  [VE2: 
#105]. 

 Attribute 1ST 5M KNOTS has a value of 0 which is not in the allowed range of (1-6)  [VE2: 
#105].  This error occurs because the STUB code is 1 and therefore, the 1st 5m knot code must 
have at least 1 quarter knots. 

 Attribute 2ND 5M KNOTS has a value of 0 which is not in the allowed range of (1-6)  [VE2: 
#105].  This error occurs because the STUB code is 2 and therefore, the 2nd 5m knot code must 
have at least 1 quarter knots. 

 Attribute MAIN (SUB) DBH LIMIT has a value of 0.000 which is not in the allowed range of 
(0.100-99.900) [VE9: #105]  The DBH limit cannot be 0, change the limit to a minimum of  0.1cm. 

 Attribute SLOPE PERCENT has a value of [  ] which is not in the allowed range of (0-150) 
[VE9: #105].  Enter a value to a maximum of 150; the MoF does not use slopes in the appraisal 
that are greater than 150%. 

 Attribute ELEVATION has a value of 0, which is not in the allowed range of (1-99950)  [VEA: 
#105].  Change the elevation to a value greater than 0.  The default is set at 1, therefore an 
error will occur unless the value is changed to 0. 
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 Attribute MAIN BAF (SUB) has a value of  [  ] which is not in the allowed range of (0.100-
99.900)  [VE9:#105].  Enter a value between 0-100. 

 Attribute HEIGHT  has a value of 0.000, which is not in the allowed range of  (0.100-99.900)  
[VE2: #105].  This error will occur if you have a tree in the compilation that does not have its 
associated type entered into the height curve table. Enter the type number that is missing for the 
species. An error will be noted when: 

 There is more than one species per curve for Appraisal Purposes. 
 There are less than 20 samples per curve for Appraisal Purposes. 
 There are less than 10 samples for one curve.  (Not enough samples to create a proper 

curve). 
 A species is put into the curve but does not exist in the data. 

106 (  ) is not a valid value for attribute: (  ). 

107 Tree Class (  )  Attribute  (  ) should not be blank. 

 Tree Class (1,2,3,5,7,8,9) Attribute 1ST KNOT should not be blank  [VE2: #107].  A tree that 
has potential volume cannot have a blank knot code, 0 is a valid number 

 Tree Class (1,2,3,5,7,8,9) Attribute 2ND KNOT should not be blank  [VE2: #107].  A tree that 
has potential volume cannot have a blank knot code, 0 is a valid number. 

108 Data item has block that does not match Tally Sheet header block. 

109 Data item has strip that does not match Tally Sheet header strip. 

110 Data item has plot that does not match Tally Sheet header plot. 
111 Attribute (  ) has a lookup code of (  ) which is not in the  (  ) lookup table. 

 Attribute SPECIES has a lookup code of [  ] which is not in the SPECIES lookup table [VE2: 
#111].  The species entered does not occur in the lookup table.  Please refer to Appendix VIII for 
valid species codes. 

 Attribute MAIN (SUB) PRISM SWEEP has a lookup code of NULL which is not in the MAIN 
(SUB) PRISM SWEEP lookup table [VE9: #111].  If the plot is a prism plot, enter either F or H.  
A fixed area plot has a blank. 

112 Attribute (  ) has a value of (  ) but should be blank. 

 Attribute MAIN (SUB) PRISM SWEEP has a value of F (H)  but should be blank  [VE9: #112].  
This error will occur when there is a value for fixed area plots.  There is no sweep for fixed area 
plots. 

113 DBH Limit has the same value for both Main and Sub plots. 

 DBH Limit has the same value for both Main and Sub plots [VE9: #113].  The main plot must 
have a larger DBH limit than the sub plot. 

114 Either Main or Sub plot has value for both Hectares and BAF. 

 Either Main or Sub plot has value for both Hectares and BAF [VE9: #114]   Either delete the 
value in the Fixed Area or  Prism field. 

115 (  ) - Species (  ) cannot have a (  ) indicator in FIZ (  ). 
 Species [  ] cannot have a “PATH REMARK” indicator in FIZ [  ]  [VE2: #115].  Each species and 

FIZ area have special rules for allowable pathological remarks.  Most likely the path code was entered 
into the wrong column 
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116 Total area by (types/blocks/harvest methods)  ( ) is not the same as the total area of 
the cutting permit(  ). 

 Total area by Types (  ) is not the same as the total area of the cutting permit (  )  [VEA: 
#116].  This message will occur when the total area of the cutting permit does not add up to the 
total area of all types. 

 Total Area by Blocks (  ) is not the same as the total area of the Cutting Permit (  )  [VEA: 
#116]. This message will occur when the total area of the Cutting Permit does not add up to the 
total area of all blocks. 

 Total area by Harvest Methods (  ) is not the same as the total area of the cutting permit ( ) 
[VEA: #116].   This message will occur when the total area of the Cutting Permit does not add up 
to the total area of all harvest methods. 

117 (  ) is an invalid DBH Limit for appraisal purposes (  ). 

 0.000 is an invalid DBH limit for appraisal purposes [Mature] or [Immature]  [VEB: #117].  
The minimum DBH limit for appraisal purposes is 0.1 cm DBH.  If a 0 cm DBH is required, the For 
Appraisal Purposes switch must be changed to NOT for Appraisal Purposes. 

 Project Standard: 0.000 is an invalid DBH limit for appraisal purposes [Exception]      [VEB: 
#117]. 

118 (  ) is an invalid Log Length for appraisal purposes in FIZ (  ). 

 [   ] is an invalid Log Length for appraisal purposes in FIZ [  ]   [VEB: #118].  For Appraisal 
purposes , FIZ A - C (Coastal ) log length = 10 m.  For FIZ D - L (Interior) log length = 5 m. 

119 DBH Limit (  ) must be greater than Top Diameter of (  ) in (  ) standard. 

 DBH limit of [  ] is less than Top Diameter of  [  ]  in Mature (or Immature) standard  [VEB: #119].  
The DBH limit MUST be greater than the top diameter. 

 DBH limit of [   ] is less than Top Diameter of  [  ]  in Exception standard  [VEB: #119] 

120 Tree (  ) is tree class 1 but has a pathological code. 

 Tree [  ] is tree class 1 but has a pathological code  [VE2: #120].  To fix this error either change 
the tree class to tree class 2 or delete the path code.  Usually this type of error is created when 
the cruiser forgets to change a tree class 1 to a tree class 2 when he finds a path remark. 

121 Tree (  ) is tree class 2 but has no pathological code. 

 Tree [  ] is tree class 2 but has no pathological code  [VE2: #121].  This type of error occurs 
because the cruiser has forgotten to record a path remark.  Unless the cruiser can remember the 
plot and record the proper path remark, the tree will have to be changed to a tree class 1. 

122 Invalid attribute combination of species (  ) tree class (  ) (  ) damage (  ). 

 Tree # [  ] : Invalid attribute combination of species [  ] tree class [  ] INSECT damage [  ]  
[VE2: #122].  Please refer to Appendix IV & V for the allowable damage/species/tree class 
combinations. 

 Tree # [  ] : Invalid attribute combination of species [  ] tree class [  ] FIRE damage [  ]  [VE2: 
#122].  Please refer to Appendix IV & V for the allowable damage/species/tree class combinations. 

1. Tree # [  ] : Invalid attribute combination of species [ ] tree class   [  ] BLOWDOWN damage 
[  ]  [VE2: #122].  Please refer to Appendix IV & V for the allowable damage/species/tree class 
combinations. 
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123 Type (  ) not found in project data. 

 Type [  ]  not found in project data  [VE9: #123].  A type has been entered in the plot cards that 
is not found in the types screen.  Either change the plot to the correct type number or enter the 
new type number in the types screen. 

124 Harvest method (  ) not found in project data. 

 Harvest Method [ ] not found in project data [VE9 : #124].  A harvest method found in the plot 
cards has not been included in the harvest methods in the Project Data map area statement 
screen. 

125 Block (  ) not found in project data. 

 Block [ ] not found in project data [VE9 : #125].  A block found in the plot cards has not been 
included in the blocks screen in the Project Data map area statement. 

126 Harvest area (  ) for Type (  ) in method (  ) has area of  (  ) but no plots. 

 Harvest Area for Type [  ] in method [  ] has area of [  ] but no plots  [VED: #126].  When the 
compilation is run block method, each area given in a harvest method  must have at least one plot. 

127 Block area for Type (  ) in block (  ) has area of (  ) but no plots. 

 Block Area for Type [  ] in Block [  ] has area of [  ] but no plots  [VED: #127].  This error will 
occur if you have chosen the Block calculation method instead of average line.  Each type and 
block area requires at least one plot for a calculation to be performed for the block method.  If the 
average line method is chosen, at least one plot in the type is required. 

128 Harvest method (  ) has no plots. 

 Harvest Area: Harvest Method [  ]  has no plots [VEF: #128].  This error occurs when:  

 The harvest method codes have been entered in the Harvest Methods screen but the 9 cards do 
not have the harvest methods entered or  are incorrectly labelled. 

 The harvest method code has been incorrectly keyed i.e. you have typed in HE instead of HL.  

129 Block (  ) has no plots. 
 Block Area : Block [  ] has no plots  [VED: #129].   Use same logic as in error 128 to fix error. 

130 Type (  ) has no plots. 
 Type [  ]  has no plots  [VEC: #130].  This error usually occurs when a type number was 

incorrectly typed in or when a plot card is mislabelled. 

131 Count tree (  ) has no plots. 
 At least one measure plot must exist in each type 

 Each tree in a count plot must have a species code and tree number 

132 Blocks in Project Identity does not match number of actual blocks in project. 

 Make sure that the total number of blocks in the data add up to the number of blocks listed in the 
field.  There is no limit to the number of blocks in a compilation. 

133 Invalid species symbol. 
 Invalid Species Symbol [  ]  [VE2: #133].  The species that was entered is not valid.  Please 

refer to Appendix VIII for valid species codes. 

134 Type (  ) Treatment Unit areas do not match areas defined in Block Areas. 
 Type : Type [  ]  Treatment Unit areas do not match areas defined in Block Areas [VEC: 

#134]  Ensure that there is not an extra area added to one of the other treatment units. 

135 Type (  )  Treatment  Unit areas do not match areas defined in Harvest Areas. 
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 Type : Type [  ]  Treatment Unit areas do not match areas defined in Harvest Areas [VEC: 
#135] Ensure that there is not an extra area added to one of the other treatment units. 

136 Special Compilation flag for Interior compilations must be WET BELT or DRY BELT. 
 For appraisal purposes, interior compilations must have either wet belt or dry belt fir chosen.  

137 Block (  ) has no area. 
 The compilation has a block entered into the blocks screen but no area has been assigned it. 

139 Height Curve has more than one species for Appraisal compilation. 
 Only one species per curve is permitted for appraisal purposes.  If there aren’t enough samples to run 

a separate species per curve, either:  go back to the bush for more samples, or get permission to run 
another species in the curve and change to not for appraisal purposes. 

140 Height Curve has (  ) samples which is below the required amount of (  ). 
 If for appraisal purposes, each curve requires a minimum of 20 samples 
 If for not for appraisal purposes, each curve requires a minimum of 10 samples 

141 Attribute (  ) cannot be zero. 

142 No block area for type (  ) in block (  ). 
 There is a plot with a certain type and block but no area is assigned to it.  This error is for block method 

only. 

143 No harvest area for type (  ) in harvest method (  ). 

 There is a plot with a certain type and harvest method but no area is assigned to it.  This error is for 
block method only. 

144 Fixed plot cannot be Count plot. 

 Only prism plots can be used for count plots.  Fixed area plots cannot derive the count ratio based on 
tree count. 

145 Reduction has both Type and Block specified. 

 A valid type number must be verified. The block and type fields cannot both have entries for the 
same compilation run.  This is a MoF rule. 

146 Reduction has invalid Type. 

 A valid type number must be verified. The block and type fields cannot both have entries for the 
same compilation run. 

147 Reduction has invalid Treatment Unit. 

 Treatment Unit can only be the letters A, B, C, D, E, F.  Do not enter any labels or numbers in the 
treatment unit field. 

148 Reduction has invalid Block. 

 A valid block number must be verified.  The block and type fields cannot both have entries for the 
same compilation run. 

149 Reduction has invalid Tree Class/Risk Group.  

 Risk Group / Tree Class:  A valid risk group/tree class must be verified.  The valid codes are 
A,B,C,D,3,4,6,7,9 only. 
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150 Reduction has invalid value (  ) for diameter class (  ) cm. 

 Diameter Classes (10-275):  A number from 0-100 can be entered.   A number greater than 100 will 
cause an error. 

151 There are redundant Percent Reduction lines. 

 More than one percent reduction was used for the same species, type, block 

152 Duplicate Plot. 

 Change the plot numbers or the strip number so that each block-strip-plot-type combination is different. 

153 Sample tree (  ) has Species that does not match value in corresponding 2 card tree. 

 Make sure that the 2 card and 3 card have the same matching species. 

154 Block (  ) has an invalid maturity value of (  ). 

 An M or an I are the only options to use in the maturity of a block.  Most often this error occurs when 
this field is blank. 

155 There are no measure trees for Species (  ) in Type (  ). 

 When compiling a count / measure cruise, at least one measure tree for each species must exist to 
provide a ratio between measure plots and count plots.  If there is no measure trees for a species in a 
type, either: change the count tree to the major species in the type or go back in the field to change the 
plot to a measure plot. 

156 Count plot not allowed in Measured plots only compilation. 

 To ensure that there are no mistakes, this error will not permit the user from compiling a measure cruise 
when there are count plots present.  Either change the cruise to a measure and count plot cruise or 
delete the count plots from the compilation. 

157 Count compilation has no count plots. 

 A count and measure plots cruise was selected but there are no count plots in the data.  Either change 
the type of cruise to measure plots only or add some count plots to the cruise. 

158 Cannot compile short logs for appraisal purposes. 

 Any small tree that cannot make one log 3 meters in length or longer is called a short log.  Some users 
still would like to compile these small trees for smallwood licenses and so an option has been created.  
However, this option is not permitted for appraisal purposes.  Change the switch to not for appraisal 
purposes. 

159 Sample tree (  ) Height must be greater than (  ). 

 The sample tree must have a height that is in the allowable range for that species and must be greater 
than 3 meters.  Only trees greater than 3 meters can be used in compilations. 

160 Percent Reduction by Block (  ) is not valid for Average Line method compilations. 

 This is an MoF rule.  When performing a percent reduction by block, only the block method can be 
used. 

161 Log Length must be greater than zero. 

 Only a log with a length can have volume.  Therefore, ensure that the log length is at least 0.1m. 

163 Min Log Length (  ) must be less than or equal to Log Length (  ). 

 The minimum log length must be less than or equal to the standard log length. 

164 Max Log Length (  ) must be greater than or equal to Log Length (  ). 
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 The maximum log length must be greater than or equal to the standard log length. 

165 Max Log Length (  ) must be greater than or equal to Min Log Length (  ). 

 The maximum log length must be greater than or equal to the minimum log length. 

166 Max Log Length (  )  must be less than the Log Length (  ) plus Min Log Length (  ). 

 The maximum log length must be less than the standard log length plus the minimum log length. 

167 DSIB of (  ) not in allowed range of (  -  ). 

 For stump cruises, the diameter stump inside bark must be greater than zero and less than 999.9 cm 

168 Stump Height of (  ) not in allowed range of (  -  ). 

 For stump cruises, the stump height of a tree must be greater or equal to zero and less than 999 cm. 

169 Count Plot DBH Limit of (  ) differs from standard utilization of (  ). 

 This is an MoF rule.  The Count plot dbh limit in the 9 card must be the same as the standard utilization.  
Simply change the dbh limit in the count plots once it has been determined what the cruised dbh is. 

170 Cannot use half count plots in compilation for appraisal. 

 Half count plots are not permitted in appraisal cruises.  If the count plot is a border plot, the rule is to 
convert the count plot to a measure plot and then the border plot is still permitted. 

171 Plot has invalid block name (  ). 

 Change the plot’s block name to a valid block name in the blocks screen. 

226 Attribute CRUISE DATE should not be blank [VE9: #226] 

 Attribute CRUISE DATE should not be blank [VE9: #226] The cruise date must be entered for each 
plot so the plot data can be evaluated according to the rules in effect at the time of cruising. 



CruiseComp User Manual   

 Industrial Forestry Service Ltd 78 

APPENDIX II - WARNINGS 

101 (  ) - Species (  ) may have an invalid (  ) indicator of FIZ (  ). 

102 Height of (  ) not in allowed range of (  -  ) for species (  )  in FIZ (  ). 

 Height of [  ] not in allowed range of (  ) for species [  ] in FIZ [  ] [VW2: #102]  Each species 
and FIZ combination has maximum heights. It was decided to omit these types of errors in the 
ERROR table for the simple because there are many trees that grow taller than the MoF tables 
indicate.  Also note that trees less than 3.0 meters are also given warnings and should not be 
compiled.  

103 DBH of (  ) not in allowed range of (  -  ) for species (  ) in FIZ (  ). 

 DBH of [  ] not in allowed range of  (  ) for species [   ]  in FIZ [  ]  [VW2: #:103]  Each species 
and FIZ combination has a maximum DBH that is given to check against the tree data.  It was 
decided not to include these types of errors in the ERROR table for the simple reason that there 
are many trees that grow larger than the MoF tables indicate. 

104 Attribute (  ) has a lookup code of (  ) which is not in the (  ) lookup table. 

106 Tree (  ) has a DBH of (  ) which is below header’s DBH limit. 

107 Tree (  ) has a DBH of (  ) which is below the utilization limit. 

108 Duplicate Tree # (  ). 

109 Age of (  ) not in allowed range of (  -  ) for species (  ) in FIZ (  ). 

 Age of [  ] not in allowed range of (  ) for species [  ]  in FIZ [  ]  [VW2: #109].  Each species 
and FIZ area has a table that gives a maximum tree age.  If the user is certain of the FIZ unit and 
the age of the tree, then there is no alternative than to change the age to the maximum age 
allowable. 

131 Count tree (  ) has no plots 

 Tree #  [  ] : Count tree [  ] has measure values  [VW2: #131]. Count plots should only have tree 
number and species recorded. 
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APPENDIX III – MAP AREA STATEMENT SPECIFICATIONS 

1.   Cruise Identity 

1. Licensee:  a maximum of 30 characters is permitted. 

2. Cruised by: a maximum of 30 characters is permitted. 

3. Project # : a maximum of 10 characters is permitted. 

4. Licence # : a maximum of 6 characters user is permitted. 

5. Permit # : a maximum of 3 characters is permitted. 

6. Blocks :  a maximum of 3 characters is permitted. 

7. Area: a maximum area of 9999999.9 ha is permitted.  

8. Elevation: a maximum elevation of 99999 m is permitted. 

9. Forest Region and Forest District are linked to the Unit ID type and number.  
Unfortunately, there is no way to link the two lists (FIZ / PSYU and Region/District) 
together as there is no MoF documentation to do so. In other words, you must ensure 
that the correct Forest District/PSYU combination has been chosen! 

10. UTM Grid: East co-ordinates permit 6 digits. North co-ordinates permit 7 digits.  If the 
co-ordinates are not known, leave the default set at  0 with a Zone of “unknown”. 

11. Locality Description :  A maximum of 27 characters is allowed. 

12. Biogeoclimatic Ecosystem Classification: Zone is selected from a drop-down list. 
Sub Zone is also selected from a drop-down list, only after the BEC Zone is selected. 
Variant is limited to one character (0 to 4) 

 

2.   Compilation Standard 

1. Damage Report:  

All damage codes will be edited for errors whether the user is compiling a damage run or 
not.  This will ensure that the data is correct for future runs.  Damage is required to 
be cruised for all trees even if there are only a few damage indicators in the Cutting 
Permit. 

2. Cutting Indicator: 

 Only values C, L, or blank are permitted for each tree.  Please note that a C or blank 
designates a cut tree.  A blank is not ignored in compiling cut cruise compilations.  
Only L codes will designate a leave tree. 

3. Double Sampling: 

 0 - Measure and Count Plots 
 1 - Measure Plots Only 
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4. Type of Compilation:  

If lumber recovery factors are to be generated, the Interior switch must be chosen.  If 
MoF computerized grades are required, choose the Coastal switch. 

5. Mature and Immature Utilization:  

If M is entered for the block maturity for a given block, then the program will use the 
mature utilizations specified in the Compilation Standard.  If I is entered for the block 
maturity for a given block, then the program will use the immature utilizations specified 
in the Compilation Standard.  Please note that the Exceptions Utilizations will always 
be used before the Mature or Immature Utilizations for the specified species. 

6. Exceptions Utilization:  

A maximum of 6 species exceptions are permitted for a compilation. 

7. Log Length:   

Any log length from 0.1 - 99.9 m can be used in a compilation for not for appraisal 
purposes.  But for appraisal purposes, only 5 m for interior compilations and 10 m for 
coastal compilations. 

8. Special Compilation:   

If you require lumber recovery factors but are getting log grades, ensure that the Special 
Compilation switch is toggled between the Wet/Dry Belt Fir and the Type of 
Compilation  switch is toggled to 3 - interior.  If  Coastal log grades are required, 
ensure that the special compilation switch is toggled on to 0 and the type of 
compilation switch is toggled to 32 - coastal. 

9. Species Compilation:   

There are no errors related to this field, but if you have a 0-exceptions not used, the 
Program will NOT compile the exception utilization limits.   

10. Calculation Method:  

The default method is Average Line Method, which uses the average of the whole type 
to derive volumes.  The block method may also be used if permission from the MoF 
has been granted. 

3.   Types 

1. Type Description:     

The maximum field length is 25 characters.  Unfortunately, the MoF has a limit of 12 
characters for this field, so when exporting your data only 12 characters will be 
exported. 

4.   Treatment Units 

Limit the number of characters for a label to 10.   
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5.   Non-Merchantable Areas 

This screen allows the user to enter in non-merchantable types that are associated with a block.  
I.e. many blocks NP areas, swamps, reserves, wildlife patches, etc.  Simply enter in the label 
description in this screen and then enter in the areas of these non-merchantable types in the 
Blocks screen.   

These labels will be reported in the cutting permit and block summary reports only.  The fields are 
located just below the header information and above the Utilization Limits in these reports. 

Please be advised that these values are not used in calculating volumes, they are only for 
descriptive purposes.  Also be advised that the Total Area field found in the header is the Total 
Area of the merchantable areas only.  This Total area does not include the non-merchantable 
areas.  The Grand Total, found at the end of the Non-merchantable area, is the total area of 
merchantable and Non-Merchantable areas. 

6.   Blocks 

1. Label:  maximum length permitted is 3 

2. Maturity: Ensure that either a M (mature) or an I (immature) is listed for each block.   

3. Block Description:  Limit length to 15 characters. 

7.   Harvest Methods 

       Ensure that the description length is less than 15 characters. 

8.   Areas 

Type, Block TU and Method are limited to drop-down lists. Maximum area permitted is 
9999.9 ha. 

9.  Height Curve 

At the moment, only 4 species can be used in calculating 1 curve.  Please note that only one 
species can be used to calculate an appraisal purposes compilation. 

10.  Percent Reductions 

Please ensure that the Apply Reductions checkbox is selected in the Percent Reduction tab 
before compiling a percent reduction cruise.  
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APPENDIX IV - TROUBLESHOOTING 

On the rare occasion, you will find that CruiseComp will perform poorly or do something unexpected. 
Many of these problems are caused by memory conflicts between the various programs that may be 
running at one time. When this happens, we recommend that you save and exit CruiseComp. Then 
reboot the computer, and resume your CruiseComp session. 

We find that it is a good habit to re-boot your computer at least once a day to avoid problems in the first 
place. 

The following is a list of solutions to problems you may encounter. 

1.  “ I don’t get any volumes in my cutting permit, block, type, and harvest reports”.   
Checklist: 

1. Is the utilization standard excluding all the trees in the compilation? 

2. Is the log length greater than 0? 

3. Is there at least one tree in the compilation?  When the program crashes it may 
indiscriminately delete all trees in the compilation or you may have entered only the 
9 header cards and forgotten to enter in the 2 card information. 

4. Is your percent reduction reducing all your trees by 100%?  If this occurs, you will 
have no volumes. 

5. If the user has a Cut / Leave Compilation switched on to Compile Leave Trees Only 
but no L trees are present, no volumes will be generated. 

 

2.  “ I don’t get any Coastal grades / lumber recovery factors”  

1.   In order to generate MoF computerized grades:  

 First, click the Type of Compilation in the Compilation Standard screen to  32-
Coastal.  

 Second, click the Special Compilation field to 0-No special compilation. 

2.   In order to generate Interior lumber recovery factors: 

 First, click the Type of Compilation in the Compilation Standard screen to 3-
Interior.   

 Second, click the Special Compilation field to 1-Interior Wet Belt Fir or 2-
Interior Dry Belt Fir. 

 

3.  “ My Pl (or other species) exception limit is not showing the correct utilization” 

1.  Check that the Species Compilation field in the Compilation Standard screen is toggled 
to  1- Exceptions Used. 

4.   “ My Damage report (Insect, Blowdown, or Fire) is not reporting” 

1. Check to see that the Damage Report field is toggled to the correct damage type. 

2. Verify that damage codes have been input and that they are in the correct columns. 

 

5.   “ My Cut Trees Only reports are the same as my full volumes reports” 
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1. Make sure that the Cutting Indicator field has been switched to C-COMPILE CUT 
TREES. 

2. Verify that not all the 2 card tree data are cut or blank values.  If there are no Leave 
trees, then the cut and full volume reports will be the same. 

 

6.   “ My percent reduction compilation is the same as the full volumes” 

1. Verify that the Apply Percent Reduction box in the Compilation Standard screen, has 
been checked. 

2. Check to see that there are percent reduction entries in the percent reduction table. 

3. Make sure that the diameter classes that you are trying to reduce have trees in them. 

4. Look to see that the species, risk group/tree class, type, and / or block are valid. 

 

7.   “ I have two old cruises that I would like to merge together…how do I do that?” 

1. If your old data is from the old Simons Reid Collins DOS program, you will need to 
perform a Disk-Export.  This should be done for as many data sets as you want to 
merge together.  Rename each export.dat a different and recognizable name so that 
there is no confusion between files.   

2. Next, open up CruiseComp and create a new project. 

3. Choose the import cruise data option. 

4. Now, choose the next data set that you would like added to the first.  When asked 
whether you want to append yes or no, choose append.  Do this for as many data 
sets as you need. 

8.   “ Why doesn’t the sum of the individual block volumes equal the cutting permit      
volume?” 

This will occur if your compilation is run using the Block Method.  The individual block 
reports are based on only the plots that actually fall within that block  (block method) and 
not on the complete timber type average for all timber types that fall within that block 
(average line method).  The total of all blocks (cutting permit) is based upon all plots in 
all timber types. 
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APPENDIX V – REPORTS REQUIRED FOR MOF COASTAL 
COMPILATIONS 

 

For Coastal appraisal compilations, the following reports are required: 

 

 Map Area Statement Report 
 Statistics Summary Reports 
 Appraisal Summary Report  
 Harvest Summary Reports 
 Volume Summary Reports 
 Damage Summary Reports (required upon MOF request) 
 Stand and Stock Tables 
 Plot Summary and Frequency Reports 
 Double Sampling Ratio (if compiled as a double sampling cruise) 
 Percent Reductions Applied table (if reductions are applied) 
 Height Curve Scattergram Report (required for stump cruises) 

 

 

Note:  If a percent reduction is being applied, two sets of the above reports will be required. One 
set showing the full volumes and then a second with the percent reduction applied. The input values 
for the percent reductions must also be provided. A third set of reports, which includes volume 
summaries, plus stand, stock and basal area tables for leave trees, is also required. 
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APPENDIX VI – REPORTS REQUIRED FOR MOF INTERIOR 
COMPILATIONS 

 

For Interior Appraisal compilations, the following reports are required: 

 Map Area Statement 
 Statistics Summary Reports 
 Appraisal Summary Reports  
 Harvest Method Summary Reports  
 Volume Summary Reports 
 Damage Summary Reports (required upon MOF request) 
 Volume and Lumber Recovery Reports 
 Stand, Stock, & Basal Area Tables 
 Plot Summary and Frequency Reports 
 Percent Reduction Applied Table (if reduction applied) 
 Double Sampling Ratio (if compiled as a double sampling cruise) 
 Height Curve Scattergram Report (required for stump cruises) 

 

Note:  If a percent reduction is being applied, two sets of the reports will be required. One set 
showing the full volumes and then a second with the percent reduction applied. The input values 
for the percent reductions must also be provided. A third set of reports, which includes volume 
summaries, plus stand, stock and basal area tables for leave trees, is also required.
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APPENDIX VII –  
VALID INSECT AND DAMAGE CODES 

VALID INSECT CODES 
 

 

Code Description    Allowable Species  Allowable Tree Classes 

 

1 Green Attack    Ba, Pl, Pw, Py, Pa, Pf  1,2,5,8  

2 Red Attack    Ba, Pl, Pw, Py, Pa, Pf  1,2,5,8 

3 Grey Attack    Ba, Pl, Pw, Py, Pa, Pf  3,4,6,7,9 

4 Blister Rust    Pw     All Classes 

5 Green Attack – Live, Strip  F, S     1,2,5,8 

6 Green Attack - Fully Attacked F, S     1,2,5,8 

7 Grey Attack - Dead   F, S     3,4,6,7,9 

8 Red Attack    F     All Classes 

 

 

VALID DEFOLIATOR CODES 

 

 

Code Description    Allowable Species  Allowable Tree Classes 

 

X Attacked - Green Cambium  All Species    1,2,5,6,8 

Y Attacked - Dry Cambium  All Species    All Classes 

 Grey or No Needles   All Species    3,4,6,7,9 
 

 

 

VALID  FIRE DAMAGE CODES 

 

 

Code Description    Allowable Tree Classes Risk Groups 

 

A Light     1,2,5,8    Based on indicators 

      3,4,6,7,9   Highest Risk group 

B Moderate    1,2,5,8    Risk group 2 

      3,4,6,7,9   Highest Risk group 

C Heavy     All Classes   Highest Risk group 

 

  



CruiseComp User Manual   

 Industrial Forestry Service Ltd 87 

 

VALID BLOW-DOWN CODES 

 

 

Code Description    Allowable Tree Classes Risk Groups 

 

E Parallel    1,2,5,8    Based on indicators 

      3,7,9    Highest Risk group 

G Shatter    1,2,3,5,7,8,9   Highest Risk group 

 

VALID ROOT ROT CODES 

 

Code   Description 

 

J Light - tree within a disease center or within 10m of a tree or stump that is symptomatic 
or killed by root disease 

 

K Moderate - tree with root disease crown symptoms 
 

L Heavy - tree with root disease confirmed by stain, decay, fruiting bodies or resinous 

 

VALID SAP ROT AND WEATHER CHECKING CODES 

 

Code   Description 

 

1 to 7 Record by tree thirds that are not suitable to produce a minimum of 50% lumber. Coding 
is the same as for pathological indicator locations. Used for the Interior hemlock and 
dead white pine grade algorithms. 
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APPENDIX VIII –  
ALLOWABLE PATHOLOGICAL REMARKS  

BY FOREST INVENTORY ZONE 

Coast Immature 

The following table is for immature trees in Forest Inventory Zones A, B & C. 

 
Species 

 
Conk 

Blind 
Conk 

 
Scars 

Fork & 
Crook 

Frost 
Crack 

Mistle 
Toe 

Rotten 
Branch 

Dead 
Top 

Douglas Fir Y Y Y Y Y Y N Y 

Cedar Y Y Y Y Y N N Y 

Hemlock Y Y Y Y Y Y Y Y 

Balsam Y Y Y Y Y Y Y Y 

Spruce Y Y Y Y Y Y Y Y 

Yellow Cedar Y N Y Y Y N Y Y 

White Pine Y Y Y Y Y N Y Y 

Lodgepole Pine Y Y Y Y Y Y Y Y 

Yellow Pine Y Y Y Y Y N Y Y 

Larch N N N N N N N N 

Cottonwood Y N Y Y Y N Y Y 

Alder Y N Y Y Y N Y Y 

Maple Y N Y Y Y N Y Y 

Birch Y N Y Y Y N Y Y 

Aspen Y N Y Y Y N Y Y 

White Bark Pine Y Y Y Y Y N Y Y 

 

Y = Yes - Indicators are allowed. 

N = No - Indicators are not allowed. 

  

 

"N" indicators will be included as warnings in the Edit Error report.  The "N" 
indicated samples would be allowed to process to completion but listed as a 
possible errors. 

 
 *Source: Revenue Branch – MoF 
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Coast Mature 

The following table is for mature trees in Forest Inventory Zones A, B and C. 

 
Species 

 
Conk 

Blind 
Conk 

 
Scars 

Fork & 
Crook 

Frost 
Crack 

Mistle 
Toe 

Rotten 
Branch 

Dead 
Top 

Douglas Fir Y Y Y Y Y Y Y Y 

Cedar Y Y Y Y Y N Y Y 

Hemlock Y Y Y Y Y Y Y Y 

Balsam Y Y Y Y Y Y Y Y 

Spruce Y Y Y Y Y Y Y Y 

Yellow Cedar Y N Y Y Y N Y Y 

White Pine Y Y Y Y Y N Y Y 

Lodgepole Pine Y Y Y Y Y Y Y Y 

Yellow Pine Y Y Y Y Y N Y Y 

Larch N N N N N N N N 

Cottonwood Y N Y Y Y N Y Y 

Alder Y N Y Y Y N Y Y 

Maple Y N Y Y Y N Y Y 

Birch Y N Y Y Y N Y Y 

Aspen Y N Y Y Y N Y Y 

White Bark Pine Y Y Y Y Y N Y Y 

 

Y = Yes - Indicators are allowed. 

N = No - Indicators are not allowed. 

  

 

"N" indicators will be noted as warnings in the Edit Error report.  The "N" 
indicated samples would be allowed to process to completion but listed as a 
possible error. 

 

 
 

 *Source: Revenue Branch - MoF 
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Interior Immature 

The following table is for immature trees in Forest Inventory Zones D-L. 

 
Species 

 
Conk 

Blind 
Conk 

 
Scars 

Fork & 
Crook 

Frost 
Crack 

Mistle 
Toe 

Rotten 
Branch 

Dead 
Top 

Douglas Fir Y Y Y Y Y Y N Y 

Cedar Y Y Y Y Y N N Y 

Hemlock Y Y Y Y Y N(1) Y Y 

Balsam Y Y Y Y Y Y Y Y 

Spruce Y Y Y Y Y Y Y Y 

Yellow Cedar Y N Y Y Y N Y Y 

White Pine Y Y Y Y Y N Y Y 

Lodgepole Pine Y Y Y Y Y Y Y Y 

Yellow Pine Y Y Y Y Y N Y Y 

Larch Y Y Y Y Y Y Y Y 

Cottonwood Y N Y Y Y N Y Y 

Alder N N N N N N N N 

Maple N N N N N N N N 

Birch Y N Y Y Y N Y Y 

Aspen Y N Y Y Y N Y Y 

White Bark Pine Y Y Y Y Y N Y Y 

 

(1) Yes for Zone J only. 

Y = Yes - Indicators are allowed. 
N = No - Indicators are not allowed. 
  

 

"N" indicators will be noted as warnings in the Edit Error report.  The "N" 
indicated samples would be allowed to process to completion but listed as a 
possible error. 

 *Source: Revenue Branch – MoF 
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Interior Mature 

The following table is for mature trees in Forest Inventory Zones D-L. 

 
Species 

 
Conk 

Blind 
Conk 

S 
cars 

Fork 
& 

Crook 

Frost 
Crack 

Mistle 
Toe 

Rotten 
Branch 

Dead 
Top 

Douglas Fir Y Y Y Y Y Y Y Y 

Cedar Y Y Y Y Y N Y Y 

Hemlock Y Y Y Y Y N(2) Y Y 

Balsam Y Y Y Y Y Y Y Y 

Spruce Y Y Y Y Y Y Y Y 

Yellow Cedar Y N Y Y Y N Y Y 

White Pine Y Y Y Y Y N Y Y 

Lodgepole Pine Y Y Y Y Y Y Y Y 

Yellow Pine Y Y Y Y Y N Y Y 

Larch (1) Y Y Y Y Y N Y Y 

          (2) Y Y Y Y M Y Y Y 

Cottonwood Y N Y Y Y N Y Y 

Alder N N N N N N N N 

Maple N N N N N N N N 

Birch Y N Y Y Y N Y Y 

Aspen Y N Y Y Y N Y Y 

White Bark Pine Y Y Y Y Y N Y Y 

 

(1)  Zones K & L. 

(2)  Yes for Zone J only. 

 

 

"N" indicators will be noted as warnings in the Edit Error report.  The "N" 
indicated samples would be allowed to process to completion but listed as a 
possible error. 

 
 *Source: Revenue Branch – MoF 
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APPENDIX IX – 
VALID HARVEST METHOD CODES 

 

CODE  DESCRIPTION 

CC Cable Clear-Cut 

CS Cable Selective Cut 

HC Helicopter Clear-Cut (Interior) 

HS Helicopter Selective Cut (Interior) 

HL Helicopter Clear-Cut - Land Drop (Coast) 

HW Helicopter Clear-Cut - Water Drop (Coast) 

SL Heli Select - Land Drop (Coast) 

SW Heli Select - Water Drop (Coast) 

FL Heli Single Standing Stem - Land Drop (Coast) 

FW Heli Single Standing Stem - Water Drop (Coast) 

HO Horse (Interior) 

LC Skyline Clear-Cut 

LS Skyline Selective Cut 

SC Ground System Clear-Cut 

SS Ground System Selective Cut 

SP Specified Operation 
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APPENDIX X – VALID AGE CODES 

 

DESCRIPTION AGE IN 10’s AGE CLASS 
1-10 years 1 1  
11-20 years 2 

21-30 years 3 2 

31-40 years 4 

41-50 years 5 3 

51-60 years 6 

61-70 years 7 4 

71-80 years 8 

81-90 years 9 5 

91-100 years 10 

101-110 years 11 6 

111-120 years 12 

121-130 years 13 7 

131-140 years 14 

141-150 years 15 8 

151-160 years 16 

161-170 years 17 

171-180 years 18 

181-190 years 19 

191-200 years 20 

201-210 years 21 

211-220 years 22 

221-230 years 23 

231-240 years 24 

241-250 years 25 

251+ years 26 9 
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APPENDIX XI – VALID COMMERCIAL  SPECIES CODES 

DESCRIPTION CODE 

Alder Dr, D, Al 

Aspen A, As, At 

Balsam B, Bb 

Amabilis fir Ba 

Grand fir Bg 

Subalpine fir Bl 

Birch Ep, E, Bi 

Broadleaf maple Mb, M, Ma 

Cedar Cw, C, Ce 

Cottonwood Ac, Ct, Co 

Cypress Cy, Y, Yc 

Fir Fd, F, Fi 

Hemlock H, He 

Western hemlock Hw 

Mountain hemlock Hm (requ’d in cgnf cruises) 

Larch L, Lw, La 

Alpine larch Li 

Western larch Lo 

Tamarack larch Lt 

Pine  

Lodgepole pine Pl, Pj 

Western white pine Pw, W, Wh 

Whitebark pine Pa, Pf, Wb 

Yellow pine Py, Pp, Ye 

Spruce S, Sp, Sx 

Black Spruce Sb 

Englemann Spruce Se 

Sitka Spruce Ss 

White Spruce Sw 

Yew (optional) T 
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APPENDIX XII –  
TREE CLASS MODIFICATION OF LOSS FACTOR TABLES 

 

Tree Class Modification Of Loss Factor Tables  

Coniferous 
All Forest Inventory Zones 

Lodgepole Pine 
All Forest Inventory Zones 

Age in Tree Classes Age in Tree Classes 

10's 1, 2, 3, 4, 6 5, 7 8, 9 10's 1, 2, 3, 4, 6 5, 7 8, 9 

2 YI M YI 2 YI M YI 

3 YI M YI 3 YI M YI 

4 YI M YI 4 YI M YI 

5 YI M YI 5 YI M YI 

6 YI M YI 6 YI M YI 

7 YI M YI 7 OI M YI 

8 YI M YI 8 OI M YI 

9 OI M YI 9 OI M YI 

10 OI M YI 10 OI M YI 

11 OI M YI 11 OI M YI 

12 OI M YI 12 OI M YI 

13 M M OI 13 M M OI 

14 M M OI 14 M M OI 

15 M M OI 15 M M OI 

16 M M OI 16 M M OI 

.. . . .. .. . . .. 

25 M M OI 25 M M OI 

YI = Young Immature OI = Older Immature M = Mature OM = Over Mature 
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Deciduous F.I.Z. A - L Except Aspen and 
Cottonwood F.I.Z. K & L 

Aspen & Cottonwood 
F.I.Z. K & L 

Age in Tree Classes Age in Tree Classes 

10's 1, 2, 3, 4, 6 5, 7 8, 9 10's 1, 2, 3, 4, 6 5, 7 8, 9 

2 YI M YI 2 YI M YI 

3 OI M YI 3 YI M YI 

4 OI M YI 4 YI M YI 

5 M M OI 5 OI M YI 

6 M M OI 6 OI M YI 

7 M M OI 7 OI M YI 

8 M M OI 8 OI M YI 

9 M M OI 9 M OM OI 

10 M M OI 10 M OM OI 

11 M M OI 11 M OM OI 

12 M M OI 12 M OM OI 

13 M M OI 13 M OM OI 

14 M M OI 14 M OM OI 

15 M M OI 15 M OM OI 

16 M M OI 16 M OM OI 

.. . . .. .. . . .. 

26 M M OI 26 OM OM OI 

YI = Young Immature OI = Older Immature M = Mature OM = Over Mature 
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APPENDIX XIII –  
COASTAL LOG GRADE ALGORITHM 

Coastal Log Grade Algorithms 
Explanatory Notes for Coast Metric Standing Tree Log Grading Flowcharts 
2. The flowcharts contain logic for restricting the grade of logs with spiral grain. 

Spiral grain (cm.) = spiral grain code from cruise sheet * 3 

3. The test for two or more other pathological indicators in hemlock and balsam is restricted 
to the following indicators: frost crack, mistletoe, rotten branches, dead or broken top and 
scars, with open and closed scars occurring together in the same tree counting as only 
one indicator. 

4. The tests for two and three or more other pathological indicators in cypress are restricted 
to frost crack, fork or crook, rotten branches, dead or broken top and scars with open and 
closed scars occurring together in the same tree counting as only one indicator. 

5. If the sum of the reported grade percents is not exactly 100 percent (due to rounding), then 
add or subtract from the grade with the highest percent to make the total 100 percent.  If 
there is a tie for the largest grade percent, then adjust the grade letter that is first 
alphabetically from B to Y. 

If D=33%, E=33% and F=33% - Adjust grade D to 34%. 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 

 *Source: Revenue Branch – MoF 
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 Douglas Fir, Pine and Larch 
 

 
*Source: Revenue Branch – MoF  
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Douglas Fir, Pine and Larch 
 

 

*Source: Revenue Branch – MoF 
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Western Red Cedar 

 

 

 
 *Source: Revenue Branch – MoF 
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Western Red Cedar 

 

 

 
 *Source: Revenue Branch – MoF 
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Hemlock and Balsam 

 

 *Source: Revenue Branch – MoF 
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Hemlock and Balsam 

 

 *Source: Revenue Branch – MoF 
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Spruce 

 

 *Source: Revenue Branch – MoF 



CruiseComp User Manual   

 Industrial Forestry Service Ltd 105 

 

Spruce 

 

 *Source: Revenue Branch – MoF 
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Cypress 

 

 *Source: Revenue Branch – MoF 
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Cypress 

 

 *Source: Revenue Branch – MoF 
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Percentages within Spruce Grades (Loss Factor) 

Natural Resource District D E F G 

Campbell River 15 16 27 42 

Chilliwack 2 41 15 42 

South Island 25 13 20 42 

Coast Mountain 5 23 13 59 

North Island - Central Coast 20 16 24 40 

Haida Gwaii 15 16 12 57 

Sea to Sky 8 4 14 74 

Sunshine Coast 0 15 0 85 
*Source: Coast Grade Distribution Report 2017-04-01 to 2019-03-31 
Mature spruce logs (greater than 120 years based on the age in 10s and tree class) will be separated into D, E, F 
and G grades where appropriate. 

Example: In the Campbell River District, when a log reaches the D/E/F/G decision box, 15% of the log net volume 
will be deemed to be D grade, 16% will be deemed to be E grade, 27% will be deemed to be F grade and 42% will 
be deemed to be G grade. 

Percentages within Spruce Grades (CGNF) 

Natural Resource District 
G F 

E D 

Campbell River  72 65 

28 35 

Chilliwack  51 90 

49 10 

South Island  76 44 

24 56  

Coast Mountain 72 75 

28 25 

North Island - Central Coast  71 54 

29 46 

Haida Gwaii  
78 45 

22 55 

Sea to Sky 
95 62 

5 38 

Sunshine Coast  
85 100 

15 0 

*Source: Coast Grade Distribution Report 2017-04-01 to 2019-03-31 
Example: 
 In the South Island District when a log is recorded as G, 76% of the log net volume will be deemed to be G 
grade and 24% will be deemed to be E grade. Similarly, when a log is recorded as an F grade, 44% will be F 
grade and 56% will be D grade. 
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Note: 
In Chilliwack, Sea to Sky, and Sunshine Coast Districts, a log recorded as E, F, or D will default to 100% G 
grade. This is due to little or no historical scale data for E, F or D grades in these districts. 
 
 
Percentages within Cedar Grades 

Natural Resource District 
D F I 

K L M 

Campbell River 
41 

59 

12 

88 

66 

34 

Chilliwack 
12 

88 

7 

93 

59 

41 

South Island 
42 

58 

10 

90 

60 

40 

Coast Mountain 
20 

80 

13 

87 

78 

22 

North Island - Central Coast 
40 

60 

11 

89 

62 

38 

Haida Gwaii 
29 

71 

14 

86 

65 

35 

Sea to Sky 
12 

88 

2 

98 

62 

38 

Sunshine Coast 
27 

73 

10 

90 

80 

20 

*Source of the table is the Coast Grade Distribution Report 2017-04-01 to 2019-03-31. 
 
Immature red cedar logs (up to 120 years old based on the age in 10s and tree Classes) flow only into the I-
grade where appropriate. Mature red cedar (greater than 120 years based on the age in 10s and tree class) will 
be separated into I and M grades where appropriate.   
 
For example, in the Campbell River District when a log reaches the D/K decision box, 41% of the log net volume 
will be deemed to be D grade and 59% will be deemed to be K grade. 
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Deciduous 

 
 

 *Source: Revenue Branch – MoF 
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APPENDIX XIV –  
INTERIOR LOG GRADE ALGORITHM 

Interior Log Grade Algorithm (no longer being used in the interior) 
START

Partition
Hemlock

Grade 5

Yes

No

Grade 4
Grade
Blank

Yes

Grade 3No

Yes

A10.2

Conk or
Blind Conk by thirds

Frost Crack in
4, 6, 7

Rotten
Branch by thirds

Dead Top
 in 1,4,6 or 7
then all logs

Dead Top
 in 2 or 5

then top 2/3

Dead Top in 3
then top 1/3

Spiral Grain >
2 in Tree

Knot code 6 in
lst or 2nd 5M log

Sap Rot/Check by thirds

Living TreeLiving Tree

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

No

No

No

No

No

No

No

No

No

No

Dead White Pine in
Licenses A 20193 - A20218

No

Yes
A10.3

Yes

 

If the sum of the reported grade percents is not exactly 100 percent (due to rounding), then add or subtract from the grade 
with the highest percent to make the total 100 percent.  If there is a tie for the largest grade percent, then adjust the grade in 
sequence from Blank to 5. 

  
*Source: Revenue Branch – MoF 
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Partition Hemlock 

As of April 1, 2002 the use of Appendix A10.2 is mandatory for Interior Hemlock from Partition Licenses. 

 

Begin at the start of A10.1.  A “YES” answer at the Partition Hemlock decision box directs the log to 
A10.2. 

 

This algorithm has been updated as of June 15, 2007.  LRF reductions are confined to only those thirds 
of the stem where frost crack occurs.  The adjacency rule for conk and blind conk is still in effect.  

 

 
 

 

 

 *Source: Revenue Branch – MoF 
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White Pine 

Conk, blind conk,
saprot/suncheck in

position other
than 1 or 3 *

Whole Tree
Grade 5

Conk or blind
conk or

saprot/suncheck
in 1

Conk or blind
conk or saprot/
suncheck in 3

Log in
lst or 2nd

3rd

Log in
2nd or 3rd

3rd

Grade 5

Grade 5

Grade 3

No No

Yes

No

No

Yes

Yes

Yes

A10.1

Yes

No

 
 

 

Pathological codes are required for White Pine tree classes 3, 7 and 9 in the Interior. 

 

*  Any combination of 1 and 3, of the pathological indicators in question, in the first decision box indicates 
a yes answer. 

*Source: Revenue Branch – MoF 
 Allocation of Path in Thirds 
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 1.  See table below for allocation of path in thirds to the log. 

 2.  Spiral grain is collected as per the Cruising Manual (at 5 m). 

 3.  Sap rot checks are collected by thirds and recorded in root rot column. 

 

No. of Path Location 

Logs 1 2 3 4 5 6 7 

1 1 1 1 1 1 1 1 

2 1 1 2 1 2 1,2 1,2 

3 1 2 3 1,2 2,3 1,3 1,2,3 

4 1 2,3 4 1,2,3 2,3,4 1,4 1 to 4 

5 1,2 3 4,5 1,2,3 3,4,5 1,2,4,5 1 to 5 

6 1,2 3,4 5,6 1 to 4 3 to 6 1,2,5,6 1 to 6 

7 1,2 3,4,5 6,7 1 to 5 3 to 7 1,2,6,7 1 to 7 

8 1,2,3 4,5 6,7,8 1 to 5 4 to 8 1-3,6-8 1 to 8 

9 1,2,3 4,5,6 7,8,9 1 to 6 4 to 9 1-3,7-9 1 to 9 

10 1,2,3 4 to 7 8 to 10 1 to 7 4 to 10 1-3,8-10 1 to 10 

11 1 to 4 5 to 7 8 to 11 1 to 7 5 to 11 1-4,8-11 1 to 11 

12 1 to 4 5 to 8 9 to 12 1 to 8 5 to 12 1-4,9-12 1 to 12 

13 1 to 4 5 to 9 10 to 13 1 to 9 5 to 13 1-4,10-13 1 to 13 

14 1 to 5 6 to 9 10 to 14 1 to 9 6 to 14 1-5,10-14 1 to 14 

15 1 to 5 6 to 10 11 to 15 1 to 10 6 to 15 1-5,11-15 1 to 15 

 

 
 

 
 
 
 

 *Source: Revenue Branch – MoF 
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APPENDIX XV –   
ALLOWABLE SPECIES BY FOREST INVENTORY ZONE 

Allowable Species By Forest Inventory Zone 

     S P E C I E S       

  F C H B S Y Pw Pl Py L Ac D Mb E AT Pa 

                  

F A X X X X X X X X C H X X X X X X 

O                  

R B X X X X X X X X C H X X X X X X 

E                  

S C X X X X X X X X X D X X X X X X 

T                  

 D X X X X X X X X X X X C C X X X 

                  

I E X X X X X X X X X X X C C X X X 

N                  

V F X X X X X G X X X X X C C X X X 

E                  

N G X X X X X X X X X X X C C X X X 

T                  

O H X X X X X A X X D X X B A X X X 

R                  

Y I X X X X X J H X G X X J A X X X 

                  

 J I X X X X X H X G I X X A X X X 

Z                  

O K I J X X X J H X G X X X A X X A 

N                  

E L I I K X X J H X G X X K A X X J 

 
X -indicates that the species may be found in the Forest Inventory Zone 

When a species is not normally found in a FIZ a letter other than an X will be present. This letter 
represents the FIZ to use for calculating volume as well as Decay Waste and Breakage for the 
species. 

When a letter other than an X is present it will initiate a warning message in the cruise compilation 
program. 

 *Source: Revenue Branch – MoF 
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APPENDIX XVI –   
MAXIMUM HEIGHT BY FOREST INVENTORY ZONE 

Maximum Height by Forest Inventory Zone  

      S P E C I E S      

  F C H B S Y Pw Pl Py L Ac D Mb E At Pa 

                  

F A 81 81 81 78 81 60 72 42 42 45 72 45 36 36 42 33 

O                  

R B 90 81 81 78 81 60 72 42 42 45 72 45 36 36 36 33 

E                  

S C 81 81 81 78 90 60 72 42 42 54 72 45 36 36 36 33 

T                  

 D 60 54 54 51 60 42 53 42 42 54 54 45 36 42 42 33 

                  

I E 72 60 60 57 57 42 60 42 48 60 54 45 36 42 42 33 

N                  

V F 72 60 60 57 57 42 60 42 48 60 54 45 36 42 42 33 

E                  

N G 72 60 60 57 57 42 60 42 48 60 54 45 36 42 42 33 

T                  

O H 60 54 54 54 54 60 42 42 42 45 54 45 36 42 33 33 

R                  

Y I 60 54 54 54 54 54 42 42 48 45 54 33 36 42 42 33 

                  

 J 60 54 54 54 60 54 42 42 48 45 60 33 36 42 42 33 

Z                  

O K 60 54 54 54 60 54 42 42 48 54 60 33 36 42 42 33 

N                  

E L 60 54 54 45 54 54 42 42 48 36 54 33 36 42 42 33 

 

Minimum height is 3 m. 

 
 

 *Source: Revenue Branch – MoF 
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APPENDIX XVII –  
MAXIMUM AGE BY FOREST INVENTORY ZONE 

Maximum Age by Forest Inventory Zone 

     S P E C I E S       

  F C H B S Y Pw Pl Py L Ac D Mb E AT Pa 

                  

F A 800 600 600 500 600 800 500 300 500 500 300 200 200 200 200 400 

O                  

R B 800 600 600 500 600 800 500 300 500 500 300 200 200 200 200 400 

E                  

S C 800 600 600 500 600 800 500 300 500 500 300 200 200 200 200 400 

T                  

 D 500 400 400 400 400 800 500 300 500 500 300 200 200 200 200 400 

                  

I E 500 400 400 400 400 800 500 300 500 500 300 200 200 200 200 400 

N                  

V F 500 400 400 400 400 800 500 300 500 500 300 200 200 200 200 400 

E                  

N G 500 400 400 400 400 800 400 300 500 500 300 200 200 200 200 400 

T                  

O H 500 400 400 400 400 800 500 300 500 500 300 200 200 200 200 400 

R                  

Y I 500 400 400 400 400 800 500 300 500 500 300 200 200 200 200 400 

                  

 J 500 400 400 400 400 800 500 300 500 500 300 200 200 200 200 400 

Z                  

O K 500 400 400 400 400 800 500 300 500 500 300 200 200 200 200 400 

N                  

E L 500 400 400 400 400 800 500 300 500 500 300 200 200 200 200 400 

 

Minimum age is 40 years. 
 

 
 *Source: Revenue Branch – MoF 

 



CruiseComp User Manual    

 Industrial Forestry Service Ltd 118 

APPENDIX XVIII - NATURAL RESOURCE REGION AND 
DISTRICT NUMBERS 

Region and District Numbers 

Area 
Natural 

Resource 
Region 

FTAS 
Code 

Number Natural Resource District Number 
FTAS 
Code 

C
O

A
S

T
 

South Coast RSC 1 

Chilliwack 01 DCK 

Sea to Sky (Squamish) 02 DSQ 

Sunshine Coast 03 DSC 

West Coast  RWC 2 

South Island 04 DSI 

Campbell River 05 DCR 

North Island/Central Coast 06 DNI 

Haida Gwaii 07 DHG 

S
O

U
T

H
 

Cariboo RCB 3 

Quesnel 01 DQU 

Cariboo Chilcotin (amalgamation) 02 DCC 

100 Mile 03 DMH 

Kootenay / 

Boundary 
RKB 4 

Selkirk (Arrow Boundary, Columbia, Kootenay 
Lake) 

04 DSE 

Rocky Mountain 05 DRM 

Thompson / 

Okanagan 
RTO 5 

Thompson Rivers (Kamloops & part of 
Headwaters) 

06 DKA 

Cascades 07 DCS 

Okanagan Shuswap 08 DOS 

N
O

R
T

H
 

Omineca ROM 6 

Prince George (+ part of Headwaters) 01 DPG 

Vanderhoof 02 DVA 

Fort St James 03 DJA 

MacKenzie 04 DMK 

Northeast RNO 7 
Fort Nelson 05 DFN 

Peace 06 DPC 

Skeena RSK 8 

Skeena Stikine 07 DSS 

Nadina 08 DND 

Coast Mountain (Kalum & N. Coast) 09 DKM 

Re-organization has resulted in the division of one district (Headwaters) and the amalgamation of several other 
districts. Names in brackets are the former district names. 

*Source: Revenue Branch – MoFLNRO 
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APPENDIX XIX – LUMBER RECOVERY FACTORS  

The following table lists the lumber recover factors in board feet per cubic meter. 

 

 

 *Source: Revenue Branch – MoF 
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 *Source: Revenue Branch – MoF 
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APPENDIX XX - CHIP YIELD FACTORS 

Chip Yield Factors 

This Appendix lists factors used to calculate chip yield (bone dry units per 100 board feet).  The factors apply to 
both Coast and Interior unless otherwise specified. 

Fir .098 
Cedar .067 
Hemlock .089 
 - Western .089 
 - Mountain .089 
Balsam .072 
 - White Fir .072 
 - Balsam Fir .072 
 - Grand Fir .072 
 - Mountain Fir .072 
Spruce .076 
 - Sitka .076 
 - Englemann .076 
 - White .076 
- Black .076 
Yellow Cedar .091 
White Pine .078 
Lodgepole Pine .087 
Albicaulis Pine .078 
Yellow Pine .095 
Larch .119 
 - Tamarack .119 
 - Western .119 
 - Alpine .119 
Cottonwood .065 
Alder .080 
Broadleaf Maples .102 
Birch .110 
Aspen .090 

 

 
 

 
 

 *Source: Revenue Branch – MoF 
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APPENDIX XXI - WET AND DRY BELT DOUGLAS FIR BEC ZONES 

Wet and Dry Belt Douglas Fir BEC Zones 

 Biogeoclimatic Zone Biogeoclimatic Subzone and Variant 

Wet Belt ICH (Interior Cedar Hemlock) dw, dk, mw, mm, mk, mc, wk, vk, vc 

Code = 1 SBS (Sub-Boreal Spruce) dh, dw, dk, mh, mw, mm, mk, mc, wk, vk 

 IDF (Interior Douglas Fir) mw, ww 

 ESSF (Englemann Spruce - 
Subalpine Fir) 

dc, dk, dv, mw, mv, mm, mk, mc, wv, 
wm, wk, wc, vc, vv 

 SBPS (Sub-Boreal Pine - 
Spruce) 

mk, dc, mc 

Dry Belt ICH (Interior Cedar Hemlock) xw 

Code = 2 IDF (Interior Douglas Fir) undifferentiated, dk1, dk2, dm2, xh, xw, 
xm, dm 

 ESSF (Englemann Spruce - 
Subalpine Fir) 

xc 

 MS (Montane Spruce) xk, dc, dk, dm, xv 

 SBPS (Sub-Boreal Pine - 
Spruce) 

xc 

 PP (Ponderosa Pine) xh, dh 

 

If subzones are missing from the above listing, the general rule to apply is:  very 
dry and dry subzones are Dry Belt; and moist, wet and very wet are Wet Belt. 

 

 
 

 
 

*Source: Revenue Branch – MoF 
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APPENDIX XXII –  
INTERIOR FIR QUALITY CLASS ALGORITHM 

Interior Fir Quality Class Algorithm 

This is computed on a tree-by-tree basis. 

Quality Class 1 

 No conk, 

 no blind conk, 

 no scars in lower third, 

 no forks or crooks in lower two thirds, 

 no frost cracks in lower third, 

 no rotten branches greater than 10 cm in diameter in lower third, 

 no dead or broken top, and 

 no 







)cm(Height

)cm(DBH
 ratio less than 1:48. 

Quality Class 2 

 Trees of lower quality than those above, and 

 tree class 3, 4, 6, 7 and 9 trees. 

 
 
 
 
 
 
 
 
 

*Source: Revenue Branch – MoF 
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APPENDIX XXIII - CRUISECOMP UPDATES 

CRUISECOMP VERSION 2019.00 (July 2019) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2019.00 
2. Spruce & Cedar grade algorithms for the coast have been updated. 

CRUISECOMP IMPROVEMENTS: 

1. A deciduous sub-total was added to the Appraisal Summary report 
2. N grades are now shown in the Log report 
3. A Burn Simulator has been incorporated into the program which modifies 

comparative cruise data to reflect the burn conditions in a fire damage stand 
without having to cruise it.  

4. Insect damage % for codes 5, 6, 7, & 8 as well as damage m3 for existing insect 
damage % lines added to the compilation dump .csv 

5. Output to Database formats now include SQLite, & PostgreSQL in 
addition to MS Access. 

BUGS FIXED: 

1. Allow the help file to be opened when no compilation file is open. 
2. The Project Report shows the correct taper equation 

CRUISECOMP VERSION 2018.00 (July 2018) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2018.00 
2. Spruce & Cedar grade algorithms for the coast have been updated. 

CRUISECOMP IMPROVEMENTS: 

1. BA/ha and Net VBAR rows have been added to the CP, Type, Block and Block 
by Harvest Method summary reports. 

2. Allow project identity elevation to be 0 or blank when unknown or not important. 
3. The log analysis reports now show the average top and bottom DIBs. 
4. The Configuration dialogue now includes options to enable/disable the creation 

of *.out files and various *.csv files. 
5. The program now detects when a count plot has been added and automatically 

selects Apply Double Sampling on the Compilation Standard tab. 
6. CP, Block and Type Basal Area Damage Table reports have been added to the 

Damage and Root Rot report group. 

BUGS FIXED: 

1. Sample trees with no counted age or a total age less than 40 are excluded from 
calculating SI 

2. Fixed bug where pressing the Cancel button and then exiting CruiseComp 
would occasionally delete the configuration file. 

3. Fixed bug in reporting project areas with no trees. 
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4. Fixed bug where lookup tables failed to update properly after importing sub-
species from .sbs or .cct files. 

5. The Damage Report option on the Compilation Standard tab is now controlled 
by the presets on the Cruise Identity tab. 

 

CRUISECOMP VERSION 2017.01 (Nov 2017) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2017.01 
2. Any spruce tree with insect damage code 7 will be moved to the highest mature 

risk group regardless of its maturity class. 
3. A new breakage table has been added to apply additional breakage allowances 

for trees with fire damage codes. Code A = 0%, Code B = 5% and, Code C = 
40% 

4. Any risk group change due to fire damage is removed. 

CRUISECOMP IMPROVEMENTS: 

1. Added a “grade sort” CSV file containing lines for each grade and EUS sort. 

BUGS FIXED: 

1. EUS output now includes conifer and deciduous subtotals. 
2. Several direct to PDF problems were fixed. 
3. Compiling with both the Compile Cut/Leave and Apply Reductions selected will 

cause a validation error. 
4. Several height curve problems were fixed. 

CRUISECOMP VERSION 2017.00 (July 2017) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2017.00 
2. Spruce & Cedar grade algorithms for the coast have been updated. 

CRUISECOMP IMPROVEMENTS: 

1. CruiseComp PDF Writer has been implemented into the program. Third party 
pdf writer programs are no longer required to create pdf documents. 

2. Export to Excel filenames will now include the filename of the source ccp file so 
the existing export files will not get over written. 

3. Network licenses are now supported. 
4. The errors dialogue is now displayed when there are no errors or warnings to 

give the user confirmation that this is the case. 
5. A warning will now pop-up if a non-ASCII character is encountered while 

importing a dat file. The warning will give the user the option of continuing with 
the import or not. 
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BUGS FIXED: 

1. Crashes caused by merging datasets have been fixed. 
2. Case sensitivity issues with species codes are fixed. 
3. Under certain conditions maturity in Type summary reports was reported 

incorrectly as “B”. This is now fixed 

CRUISECOMP VERSION 2016.01 (Jan 2017) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2016.01 
2. Pl breakage table has been updated 

CRUISECOMP IMPROVEMENTS: 

1. Output tables have been updated for the Enfor Appraisal program. 
2. Importing EUS matrix from CSV files now allows a trailing “%” on percent 

values. 

BUGS FIXED: 

1. Error pop up added to advise of area incompatibility when merging files. 
2. Added calculation warning if a species code and grade combination cannot be 

matched in the log_length_output_classes table, or a length diameter match 
cannot be found. 

3. Removed log length warnings when log length rules are not being used. 

CRUISECOMP VERSION 2016.00 (July 2016) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2016.00 
2. Spruce & Cedar grade algorithms for the coast have been updated. 

CRUISECOMP IMPROVEMENTS: 

1. Data can now be compiled using Block by Harvest Method. 
2. Area input tables upgraded to allow Block by Harvest Method compilations. 
3. New module added for Custom Log Lengths 

BUGS FIXED: 

1. Cypress is now exported to the MoF CSV file. 
2. A complete review of grade algorithms was done with corrections made. 
3. EUS crash fixed. 
4. EUS table update error on old files fixed. 
5. Calculation Error to include report name to make it easier to trace the error. 
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CRUISECOMP VERSION 2015.00 (July 2015) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2015.00 
2. Spruce & Cedar grade algorithms for the coast have been updated. 

CRUISECOMP IMPROVEMENTS: 

1. End Use Sort Module now imports and export csv files. 
2. Calculation error report introduced. See Sect. 2.7 for details 

BUGS FIXED: 

1. Added a deciduous field to the appraisal xml. 
2. BEC variant now allows values 1-4. 
3. Percent reductions for risk groups A to D now only apply to live trees. 
4. Dat/cct file import issue fixed. 
5. Problem validating data with too few sample trees fixed. 

CRUISECOMP VERSION 2014.00 (July 2014) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2014.00 

2. CruiseComp has been updated to reflect the 2014 Forest Region and Forest 
District re-organization. 

3. Coast Mountain Natural Resource District can be compiled as Coastal or Interior 
when FIZ is set to A. 

4. Shuswap PSYU will now compile in FIZ D and G. 
5. First Nations Woodlot License has been added to the Tenure List on the Cruise 

Identity tab. 
6. The Interior Appraisal Report now reports red/grey pine beetle percent to one 

decimal place by block. 
7. The number of potential trees is now calculated differently in loss factor, & cgnf 

compilations. 

CRUISECOMP IMPROVEMENTS: 

1. Deciduous subtotals are now reported wherever conifer subtotals are reported. 
2. A deciduous column has been added as the last column in the csv output file. 
3. Grand fir can now be quickly separated from or combined with other balsam fir 

species, for compilation, by using the checkbox option in the advance section of 
the Compilation Standard Tab. 

4. CSV output summaries can now be generated for “Not For Appraisal” 
compilations. 

BUGS FIXED: 

1. Minimum 8m U grade warning message for Tree Class 3 trees has been replaced 
with an error message for dead trees with only X/Y 99 grades. 

2. The Double Sampling Ratio was fixed for CGNF compilations. 
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3. The CGNF potential tree calculation now excludes graded trees that have no 
volume. 

4. Several internal issues that caused CruiseComp to crash have been fixed. 

CRUISECOMP VERSION 2013.01 (July 2013) 

MINISTRY OF FORESTS CHANGES: 

1. The validation rules have been revised to comply with the latest tree class 3 or 4 
tally/no tally definitions from the MoF. 

BUGS FIXED: 

1. Cruise Date now reports correctly on the Appraisal Summary Report 

CRUISECOMP VERSION 2013.00 (July 2013) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2013.00 
2. Special Sale Area Dawson Creek has been added back into FIZ L. 
3. Spruce/Cedar grade algorithms for the coast have been updated. 
4. A CSV output summary will be created for appraisal compilations. This file is 

created only when data is for appraisal purposes and is created in the same 
place where the ccp is found. 

CRUISECOMP IMPROVEMENTS: 

1. VBAR Plot Summary report has been added, allowing plot volume reports for 
count & Big BAF plots. 

2. Net VBAR Statistical Analysis report has been added. 
3. Partial Cut Percent report has been added. 
4. Statistics are now output to the (output_stats_b table) cco file. 
5. A warning is created when the only measure tree of a species is below the 

utilization limit in double sampling ratio or Big BAF compilations. 
6. A new Ht./DBH ratio warning validation has been added to check for odd looking 

trees. 

BUGS FIXED: 

1. Basal Area & Basal Area/ha values output to cco file fixed. 
2. VBAR output to cco file fixed. 
3. Error in reporting some non-appraisal species in “Not for Appraisal” compilations 

fixed. 
4. Park Unit ID Type no longer causes program crashes. 
5. Grade problems with duplicate trees fixed. 
6. Conflict between sub species module and EUS module fixed. 
7. Statistics reporting for Big BAF compilations fixed. 
8. EUS percent validation warning fixed. 
9. Harvest method descriptions for SL & SW fixed. 
10. Treatment Unit descriptions now exported to dat file correctly. 
11. Revised minimum 8m U grade filter for cgnf compilations. 
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12. EUS grade validation warning fixed. 

CRUISECOMP VERSION 2012.00 (June 2012) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2012.00 
2. Cedar shingle historic rollups for loss factor grade algorithms. 
3. Spruce hi-grade historic rollups for loss factor grade algorithms. 
4. Spallumcheen PSYU & FIZ D combination added. 

CRUISECOMP IMPROVEMENTS: 

1. Presets have been updated to ensure that exception limits and utilization limits 
change to the appraisal limits. 

2. Top DIB can now be larger than the DBH. Instead of an error, a warning is 
produced. This only affects not for appraisal compilations. 

3. End Use Sort module default diameter classes are now being saved. 
4. End Use Sort module matrix can be deleted and eus file can now be imported 

without adverse effects.  
5. End Use Sort module creates message when tree is not found in Block Area 

EUS Map screen. 
6. Post 2012 release: working on big baf stats – plot summary 
7. Post 2012 release: continuing to update memory collections 
8. Post 2012 release: continuing to update jurisdictions to compile for all areas in 

Canada. 

BUGS FIXED: 

1. Duplicate plot error has been fixed when adding plots. 
2. Export of IFS appraisal cruise data xml exports consistently. 
3. Big BAF cruises no longer require that the plot type is M, can also be called C. 
4. Output cco tables output Hw and Hm as species 3.   

CRUISECOMP VERSION 2011.00 (June 2011) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2011.00 
2. Cedar shingle historic rollups for loss factor grade algorithms. 
3. Spruce hi-grade historic rollups for loss factor grade algorithms. 
4. Added count of plots > 5 yrs old & > 10 yrs old in the appraisal report. 
5. Cranbrook PSYU & FIZ E combination added. 
6. Last log in a CGNF compilation is automatically changed to a Y grade if it is > 

2.9m and < 5.0m and the second to last log is an N or Z grade. 
7. Last log in a CGNF compilation is automatically changed to a Z grade if it is < 

3.0m the second to last log is an N grade. 

CRUISECOMP IMPROVEMENTS: 

1. A new progress indicator bar has been added. 
2. Elapsed time indicator added to status bar. 



CruiseComp User Manual    

 Industrial Forestry Service Ltd 130 

3. Plot list can now be sorted on M/C value. 
4. XML appraisal summary export file added. 

BUGS FIXED: 

1. A number of memory leaks have been located and fixed. 
2. Plot number displays correctly when a new plot is added. 
3. Validation of non-existing log grades fixed. 

CRUISECOMP VERSION 2010.00 (July 2010) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2010.00 
2. Update the coast spruce log grade algorithm high grade percentages. 
3. Update the coast cedar log grade algorithm shingle grade percentages. 
4. Added Net Volume/ha for All, Live, and Dead Potential trees on the Interior and 

Coast Appraisal summary. 
5. Added Net Volume for All, Live, and Dead Potential trees on the Interior and 

Coast Appraisal summary. 
6. Added Lodgepole Pine red/grey MPB % by block on the Interior Appraisal 

summary. 
7. Ordered species in the appraisal reports alphabetically according to MOF 

species code. 
8. Added 2nd growth % for coastal Cutting Permit, Block, and Type Summaries. 
9. Moved Non Heli Select conifer (m3/ha) in coast appraisal report from the All 

Method section to the Cutting Authority Section. 
10. Added Heli Select Total Species and Heli+Skyline Total Species reported as a 

decimal to the coast appraisal report. 

CRUISECOMP IMPROVEMENTS: 

1. Updated both coast and interior appraisal summaries. 
2. Added jurisdiction to the Project Identity tab for non BC users. 
3. Added build number to the version so that users will know which compiled build 

they have for debugging. 
4. Added the ability to report non-appraisal species using the Not for Appraisal 

Purposes selection. 
5. Fixed a bug in the immature coastal taper function. 
6. Added Title Page, including cruised by and compiled by, reports either loss factor 

or call grade net factoring cruise. 
7. Printing bug fixed when no damage reported, caused a problem in the printing 

sequence. 
8. Harvest methods shown for coast only or interior only depending on presets 

chosen. 

CRUISECOMP VERSION 2009.00 (June 2009) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2009.00 



CruiseComp User Manual    

 Industrial Forestry Service Ltd 131 

2. The second growth net volume for all of the coniferous species has been added 
to the Coastal Appraisal Summary Report. 

3. FIZ H and FIZ I are now allowed in Babine PSYU. 
4. The Queen Charlotte Island Forest District is now reported as Haida Gwaii.  
5. Update the coast spruce log grade algorithm high grade percentages. 
6. Update the coast cedar log grade algorithm shingle grade percentages. 

CRUISECOMP IMPROVEMENTS: 

1. Log analysis module was showing unspecified volume when first top diameter 
class was different from utilization limit 

2. Plots/ha calculation was using the wrong number of plots when calculating the 
value for a specific block. 

3. Export to Excel module fixed the off by one report error. 
4. Input focus goes to the Block field when data entering in the Tally Header card. 
5. Sorting of strip and plot were updated 

CRUISECOMP VERSION 2008.00 (June 2008) 

MINISTRY OF FORESTS CHANGES: 

1. Version has been updated to 2008.00 
2. All trees must have measure information for each species occurring in a timber 

type, in count plots and mark to cut and leave cruises. 
3. Allow beetle codes 1, 2, & 3 for all species of the Pinus genus. 
4. Added Special Cruise Number 233 to be used as a new PSYU for the Gulf 

Islands in FIZ C. 
5. Added Special Cruise Number 234 to be used as a new PSYU for E&N lands 

with the Quadra PSYU in FIZ B  
6. Added Special Cruise Number 235 to be used as a new PSYU for E&N lands 

with the Vancouver PSYU in FIZ C. 
7. Allow FIZ D and G in the Salmon Arm PSYU. 
8. Allow live and/or dead column with the risk group column when calculating 

percent reductions. 
9. Use newer stump to DBH equation coefficients for H, S, C, and Yc, in the Queen 

Charlotte Islands PSYU. 
10. Ground skidding (SS & SC) harvesting methods to include hoe chucking. 
11. Update the coast spruce log grade algorithm high grade percentages. 
12. Update the coast cedar log grade algorithm shingle grade percentages. 

CRUISECOMP IMPROVEMENTS: 

1. Fixed crash when looking at Block Summary, or Extended Block Summary 
reports. 

2. Erroneous Plot Not Found error message fixed.  
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CRUISECOMP VERSION 2007.01 (Nov 2007) 

MINISTRY OF FORESTS CHANGES: 

1. Update interior appraisal report to include green, red, grey attack Lodgepole 
Pine, and all other species insect attack. 

2. Version has been updated to 2007.01 

CRUISECOMP IMPROVEMENTS: 

1. Page numbers for individual reports were not indexing correctly at the top right 
hand side of all reports. 

2. Defoliator insect damage codes were not importing into CruiseComp from the dat 
file. 

CRUISECOMP VERSION 2007.00 (June 2007) 

MINISTRY OF FORESTS CHANGES: 

1. Right of Way area removed from the CP must be reported in the cruise 
compilation.  Inside the non-merchantable areas section of CruiseComp, “R/W 
Removed” will be set as a default area.  Please be sure to enter the R/W area 
removed.  A new card type “H” will be implemented to save these areas to the 
map area statement.  The areas will be reported on the block summaries in the 
header as usual. 

2. The Revenue branch has asked that we add “All” in the percent reductions report 
if all species have been applied to a reduction.  In the past, our program left the 
field blank. 

3. The Interior Hemlock algorithm has been updated so that LRF = 0 only in those 
tree thirds where frost crack occurs. The adjacency rule for conk and blind conk 
will still be in effect. 

4. A non heli select volume/ha for conifers field has been added to the appraisal 
report. 

5. Some new harvest methods have been added for coastal heli methods: 
 SL Heli single tree selection land drop 
 SW Heli single tree selection water drop 
 FL Heli single standing stem land drop 
 FW Heli single standing stem water drop 

6. Coastal Cedar and Spruce high grades will be rolled up to represent  the last two 
fiscal year’s scale grade production. 

7. The coast requires a change to the appraisal summary.  The net vol/10m log is 
being changed to Piece size and only conifer volume instead of total volume is 
summarized as per appraisal branch requirements. 

8. Version has been updated to 2007.00. 

CRUISECOMP IMPROVEMENTS: 

1. For call grading compilations, small trees with only 1 log (J 99)  that would 
otherwise produce a grade error for log length too short (i.e. < 5.0) are now 
allowed as long as the single log length is >= 3.0. 
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2. In the call grading module, a checkbox has been added to turn off the Pl 
breakage add-on.  This is used when the latest Pl breakage factors are not 
required. 

3. The end use sort module is no longer capping the percentages to 100%.  Users 
can now enter more than 100% values for a species and grade. 

4. An incorrect adding error for very large areas was corrected. 
5. For count plot/measure tree sampling cruises, trees that don’t qualify as measure 

trees are automatically converted to count trees to ease in validations. 

CRUISECOMP VERSION 2006.02 (Jan 2007) 

MINISTRY OF FORESTS CHANGES: 

1. The CGNF system has been implemented for the coast.  Use “For MPS 
Purposes” only.  

2. Version has been kept at 2006.02 

CRUISECOMP IMPROVEMENTS: 

1. Added Preset selections for coast CGNF, coast loss factor and interior loss 
factor compilations. 

2. Grade validations have been updated.  
3. Improved the Big BAF module in filtering measure trees. 
4. Updated the header reports. 
5. Fixed importing of cct  datasets. 

CRUISECOMP VERSION 2006.02 (Nov 2006) 

MINISTRY OF FORESTS CHANGES: 

1. Allow Root Rot code “R” for percent reductions.  This will allow root rot affected 
trees to be compiled for harvesting. 

2. Add in validation error for orphan species in count/measure compilations for tree 
class 4 or 6 trees. 

3. Delete All Method slope in the Appraisal report for coastal compilations. 
4. Version changed to 2006.02. 

CRUISECOMP IMPROVEMENTS: 

1. Updated the Call grading module to include the latest changes from the CGNF 
committee.  

2. Plot field is now alpha/numeric.  Therefore, both alpha and numeric data can 
be entered in the plot. 

3. Added one decimal place to the Second growth and immature % fields. 
4. Updated the PDF writer.  Requires a new download of the Postscript windows 

driver from Adobe. 
5. Added a validation error that checks that the damage report is selected for 

appraisal purposes. 
6. Improved the validation of call grades. 
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CRUISECOMP VERSION 2005 

MINISTRY OF FORESTS CHANGES: 

1. Allow 99 Treatment Units in a compilation. 
2. Percent reduction worksheet expanded to accept 100% 
3. Coastal cedar and spruce high grades are rolled up to represent the last two 

fiscal years scale grade production in the coast log grade algorithms. 
4. Slope statistics are now reported  by block. 
5. Option to compile and report leave trees. 

CRUISECOMP IMPROVEMENTS: 

1. A new set of database tables replace the old TALLY tables. CruiseComp handles  

the conversion and transfer of data when loading projects.  

2. The maximum number of custom grade logs per tree increased to 12. 
3. A new button on the toolbar allows to view the status of and enable/disable  

the option to output to the database. 

4. CCT file exports 6 digit tree numbers for tally trees, sample trees and growth 
rates. 

5. A "New Stump" menu added to the file menu to create new stump cruise 
projects. The old "New" menu and toolbar now creates regular cruise project. 

6. Grades S and N added to the list of valid alpha grades 

CRUISECOMP VERSION 2004 

MINISTRY OF FORESTS CHANGES : 

1. The cruise date is a mandatory entry for 2004.  The cruise date must be entered 
on every plot. 

2. The cutting permit and block CV are not being used and will not be reported this 
year. 

3. Two more categories in the percent reduction module have been added.  Code L 
will indicate all live tree categories in all Risk Groups.  Code R will indicate all 
dead tree categories. 

4. The program will allow 12 treatment units. 
5. Three new coastal harvest methods have been added.  HL – Helicopter Land, 

HW – Helicopter Water and HF – Helicopter Single Stem.  The other current 
helicopter methods HC and HS will be used only for interior areas. 

6. The coast appraisal report will calculate a conventional slope for all non 
helicopter harvest methods.  Height curves will be permitted for the Helicopter 
single stem harvest method.  A minimum of 20 samples per species per timber 
type is required to generate the curves. 

7. The Cedar shingle and Spruce high grades are being updated based on the last 
2 years scale. 

The dat file will now be versioned so that old and new datasets can be correctly 
imported into the program. 
8. LRF calculation for Hemlock Partition for Kalum/Skeena districts has been 

changed (2004.1) 
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CRUISECOMP 2004.0 IMPROVEMENTS: 

1. The All Treatment units page is now reporting in front of the individual treatment 
units. 

2. New fields (Map sheet number, photo number and forest cover) added to the plot 
card. 

3. Summary of all treatment units added to area and stand/stock damage reports. 
4. Convert multiple dat files in the File menu (Import and save) permits the user to 

create many ccp files from multiple dat files at one time. 
5. Count trees with dbh entered will be used to determine if the tree is big enough 

for the utilization limits. 
6. Count trees with the cut/leave indicator will be recognized in cut-leave 

compilations. 
7. User can control which tables are output to database found in the configuration in 

the File menu. 
8. Count plots shown in plot summary report. 
9. The speed of calculation has been greatly improved. 
10. The type number field length extended to four digits. 
11. Implemented Sentinel Superpro 6.3.1 API. Server license keys are now 

available. 
12. A new set of database tables replace the old TALLY tables. CruiseComp handles 

the conversion and transfer of data when loading projects. 
13. Project files created in Microsoft Access 97 are upgraded to Access 2000. 
14. A new Total column added to the types property page to represent the total 

area of all treatment units. 

CRUISECOMP PROBLEMS ADDRESSED: 

1. Program error compiling under-sized trees. 
2. Program Error while calculating stats. 
3. No Snags per Hectare in summary reports if tree class 4 or 6 is the only existing 

tree of a certain species. 
4. Entering duplicate trees on the same tally sheet caused loss of data. 
5. Preferred Grade Length validation not functional for user grades. 
6. Intermittant Program Error while navigating through a long list of plots. 
7. Misplaced stats row values when user grades don't fit. 
8. Unspecified ADO error message when outputting NULL grades. 
9. An empty count plot not displayed in the plot summary report. 
10. Tab and Arrow keys would not allow navigation inside a spreadsheet on map area 

statement property pages 
11. Program error printing the Project Description report.  
12. Error when updating old project files on some Windows 2000 machines. 
13. Application failure when right-clicked on block-area page of the map area 

statement right after creating a new project. 
14. Application error printing the Statistical Volume Analysis report for some 

Count/Measure Trees sampling cruises. 
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CRUISECOMP VERSION 2003 

MINISTRY OF FORESTS RECOMMENDED CHANGES: 

1. Block method compilations are no longer permitted for appraisal cruises.  For 
coastal mixed block utilization situations or if block reductions are required, 
assign unique types to each block.  The program permits compiling the block 
method for non-appraisal cruises. 

2. The Ministry of Forests has re-organized.  The Region and District names have 
been changed.  This will create some versioning problems using old datasets but 
we have provided a conversion inside CruiseComp to handle this.  For any MOF 
dat file that is imported into CruiseComp, a message box will ask the user if the 
dat file was created pre-April 1, 2003 or after.  This will allow the program to 
convert the data.  The cct file will have a version number added so that the 
program will know what version is being imported. 

3. A warning message will report when cruise date is not entered for each plot.  We 
are expecting this warning to become an error next year. 

4. The Tree Maturity table has been modified so that young immature, old immature 
and mature loss factors can be used in a plot.  

5. A new rule has been added to the height curve selection.  When the parabola b 
and c coefficients are both positive, the Weibull function must not be used. 

6. On Forest License A57077 in the Bulkley TSA, the LRF compiled for balsam is to 
be based on the sawlog component only.  Any balsam that has greater than or 
equal to 48% DWB will have zero LRF assigned to the volume of the tree.  The 
average LRF will be lowered due to this new rule. 

7. The net volume per hectare will be reported to three decimal places on the All 
Method and Harvest Summary reports. 

8. The Appraisal Summary is now mandatory for April 1, 2003. 
9. The totals have been added for the Appraisal Summary.  Previous years reported 

the data by harvest method only. 
10. The Larch genus will use the Fir/Pine coastal grade algorithm. 
11. The Coastal cedar and spruce high grade breakdowns have been updated. 
12. The allocation of path in thirds matrix has been expanded to accommodate a tree 

with greater than 60 meters merchantable height. 
13. The allocation of path in thirds matrix for a stem with five logs was corrected. 
9. For licenses A20193 and A20218, a new algorithm utilizing conk, blind conk, sap 

rot and sun checks will be used for dead white pine.  The LRF for the grade 5 
trees will be zero. 

 CRUISECOMP 2003.0 IMPROVEMENTS: 

1. We have updated our program from the DAO database technology to the ADO 
database technology.  This will allow our users to work in Access 2000.  The 
newer technology will also allow Windows 2000 and Windows XP users to run 
our program.  Please notify us if you experience any difficulties during the 
installation.  There have been some fundamental changes in this new release. 

2. You will notice that we have improved the look of our reports.  The report titles 
and major headings have been bolded.  Shading has been added to aid in 
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reading the reports.  We have added a line to the footer of each report that 
indicates the CruiseComp copyright. 

3. For users who have purchased our Cruiser Call module, customized user grades 
have been added.  This will allow the user to create any alpha grade or number 
grade desired.  We have also added the ability to create customized validations 
for each grade (by species, min and max top diameter, log length and net factor.  
We have also added the ability to validate for preferred lengths, invalid pathology 
and invalid species.    

4. For users who have purchased our Log Analysis module, we have added a new 
toggle that compiles the butt diameter of the log. 

5. The Extended CP, Block and Type Summary reports have two new fields.  Both 
Net Merch – Live and Net Merch – DP have been added. 

CRUISECOMP PROBLEMS ADDRESSED: 

1. Some quality remarks were not being validated as errors. 
2. Some errors resulted in the summary reports when only deciduous species were 

present. 
3. Some height curve logic has been changed to meet  MOF specifications. 
4. Some incorrect tree class percent calculations in the Extended Type Stand and 

Stock table have been fixed. 
5. Trees/plot average was calculating only compiled trees/plot instead of cruised 

trees/plot. 
6. When printing the Map Area Statement, some datasets caused the program to 

crash. 
7. The merchantable height calculated incorrectly for very small trees. 
8. There was an error in calculating the 2SE% in the block summary for some 

datasets. 

CRUISECOMP VERSION 2002 

MINISTRY OF FORESTS RECOMMENDED CHANGES: 

1. Interior Partition Hemlock Licenses will have certain trees/logs in Hemlock 
downgraded from sawlog to pulp with a resulting zero LRF.  A new selection under 
type of compilation has been added for the partition licenses.  This reduction in LRF 
will only occur in the Partition Licenses. 

2. For Coastal cruises, the cedar grades will now report shingle grades again.  The 
separations will work in the following manner: D and K grades, F and L grades, I and 
M grades.  For example, the K shingle grade will derive itself from D grade logs.  The 
logic works in the same way as for premium spruce grades (D,E,F and G)  For 
example, in the Campbell River District, a log that compiles as  D grade, will now be 
split up into 39% D grade and 61% K grade.  Cedar grade separation for I and M 
grades will only apply to mature cedar.  All immature cedar grade I logs will flow into 
the I grade decision box and will not be separated into M shingle grades.  The D/K and 
F/L separations are not affected since D and F grades can only be mature logs. 

3. Spruce premium grades have been rolled up to represent the last two years scale 
grade production. 
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4. The timber type reports will now report the average trees/plot as shown in the cutting 
permit report. 

5. The Kalum district West of the Cascades will now use Interior standard utilization 
specifications.  Choose the interior switch to compile in this area from now on. 

6. For appendices 2-5 in the MoF design manual, limitations set out in these tables will 
not result in fatal errors but instead carry warning messages.  These appendices 
include the following tables:  

a. allowable species by FIZ  
b. allowable pathological remarks by species, FIZ and maturity 
c. allowable heights by FIZ and species 
d. allowable maximum ages by FIZ and species.   

From now on please be very careful in checking your warning messages!  For 
example, a tree height of 99 meters will not produce a fatal error anymore but only a 
warning.  This tree is more than likely an error but will be compiled as if correct. 

7. When a species is not normally found in a FIZ, the program will now allow the species 
to compile and use the FIZ that is closest with the species to calculate volume as well 
as decay, waste and breakage for the species. 

8. For the Interior algorithm: Positions 4 and 6 will be added to dead top in 1 and position 
5 will be added to dead top in 2. 

 
9. The statement “PERCENT REDUCTION APPLIED” will be reported in upper case and 

double-spaced at the top of all pages when the reductions applied box is checked. 
10. All summary pages with volume per hectare values will now report to the nearest whole 

number.  (This applies to the harvest and appraisal pages as the cp, block and type 
summaries already were doing this.) 

11. There were a few things that have been changed for the height curve reports.  DBH 
max will be 250 cm for all curve equations.  For Weibull curves, the maximum number 
of iterations is 1000.  Use a minimum of 10 trees per curve instead of 20 for minor 
species.  On all scattergrams a message will appear stating that: “Major species height 
curves require a minimum of 20 sample trees, minor species height curves require a 
minimum of 10 sample trees.  Combined curves require a minimum of 20 sample trees.  
Failure to meet these standards will result in rejection of the cruise.”    

CRUISECOMP 2002 IMPROVEMENTS: 

1. The LRF report has been expanded to summarize by block and type.  The old LRF 
report is now called the CP Volume and Lumber Recovery Information Report. 

2. The Stand/Stock/Basal Area reports will now also summarize individual treatment 
units.  These reports should help improve checking of cutting percent reduction 
prescriptions. 

3. The main interface now displays at the bottom a summary of the number of plots and 
the number of plots selected.  

4. Cruisecomp will remember the print settings from the last print job.  For example, if the 
program used landscape the last time, the next time the program will print in 
landscape. 

5. For printers that print double sided, the reports will start on the first page for a new 
report not on the back page. 
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6. CruiseComp’s import/export functionality has been improved.  A new file has been 
created called a CCT file.  The DAT file is the MoF text format.  The CCT file is IFS's 
text file format.  This format saves ALL settings and switches to a file for all modules.  
This file will be invaluable when archiving files because everything is saved.  The DAT 
file only has the Map Area Statement and MoF plot information stored.  The CCT file 
can be imported/exported in the same manner as the DAT file. 

7. The report header section has been reworked.  Because of the new changes, we 
needed to adjust how the fields were being reported in the header information at the 
top of the reports.  The percent reduction comment was required at the top of the page.  
Also, the reduced hemlock LRF had to be inserted in the header.  

8. The height curve reports have the number of sample trees and number of trees per 
diameter class included in the height equation table for better reference in determining 
number of sample trees and the total number of trees in the curves. 

CRUISECOMP PROBLEMS ADDRESSED: 

1. Using treatment units and percent reductions wasn’t working as desired.  This part of 
the program has been overhauled and should be working in all instances.  The addition 
of the stand/stock/basal area tables by treatment unit should help in checking 
reduction prescriptions. 

2. The LRF was being rounded differently between the LRF and CP summaries.  This is 
has been corrected.  The rounding was different by 1 LRF point in some instances. 

3. The short trees that are changed to tree class 4 and 6 will now be viewable at the 
bottom of the summary reports.  Depending on the data set, sometimes this summary 
line was not visible because there were too many fields reported.  Some blank lines in 
the summary report had to be deleted to ensure that these lines are always visible. 

4. Some trees’ last log volumes were calculating slightly different values.  The logic has 
been changed and is consistent with the MoF calculations. 

CRUISECOMP VERSION 2001 

CRUISECOMP IMPROVEMENTS: 

1. The exported data set format has been modified to be directly compatible with the MoF 
ASCII format. 

2. Stand Utilizations for Appraisal Cruises are now defined for the whole province. The 
utilization’s are as follows: 

Interior:All maturities: dbh 17.5cm, top diameter 10.0cm, stump ht 30cm 
There are only two exceptions to the utilization rule: 
Lodgepole Pine: dbh 12.5cm, top diameter 10.0cm, stump ht 30cm 
Cedar: dbh 17.5cm, top diameter 15.0cm, stump ht. 30cm 

Coastal: Mature: dbh 17.5cm, top diameter 15.0cm, stump ht 30cm 
  Immature: dbh 12.0cm, top diameter 10.0cm, stump ht 30cm 

If a compilation does not have these utilizations and the user is compiling an Appraisal 
Compilation, the program will produce an error stating that the utilizations are not set 
to the Appraisal Standards. 

3. Two additional columns have been added to the “2 card” to accommodate tree 
numbering from 1 – 9999 for 100% stump cruises. 
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4. The compilation specifications have been changed when compiling stump cruises. The 
merchantable volume calculations will include that portion of the tree cut below 30cm 
in a stump cruise. Trees with stumps greater than 30cm will continue to be compiled 
to the 30cm stump height standard. 

5. The new Spruce High Grade percentages have been updated for the new 2 year 
average for Coastal Districts. 

6. The Interior Grade Algorithms have been updated by deleting the two Insect/red attack 
decision boxes for chipper and sawlogs. 

7. Some PSYU and TFL areas have been updates. The changes are as follows: 
A. TFL 24 has been deleted and added to TFL 25, Unit 4. Use FIZ A loss 

factors for all species. 
B. Kamloops PSYU: allow FIZ G (new) as well as D. 
C. Niskonlith PSYU: allow FIZD (new) as well as G. 

CRUISECOMP VERSION 2000.1 

CRUISECOMP PROBLEMS ADDRESSED: 

1. The Stump Cruise Module has been fixed to facilitate the correct importing of 
stump height. 

2. The coastal grade algorithm in the Stump Cruise module has been modified.  The 
top diameter is now the only parameter used to identify grade. This is a 
requirement of the Ministry of Forests. These grades will be used if historic or 
other adjacent cruises cannot be used for the trespass. 

3. Previously, the partial cut percent field – included in the new appraisal report – was 
calculated incorrectly if cut/leave cruises were compiled.  Now, if the “C-Compile 
Cut Trees” switch is selected, volumes are added in the calculation of the partial 
cut percentage.  This switch functions similar to the “percentage reduction” switch. 

CRUISECOMP 2000.1 IMPROVEMENTS: 

1. Timesaving features have been added to the user interface. The user is now able 
to modify many plots at the same time by highlighting the desired plots in the left-
hand window of the main plot interface, clicking  the right mouse button and 
selecting the desired field in which changes are to be made. All fields included on 
the “9” card can be modified in this manner.  Changes made to the “9” card will be 
effected for all highlighted plots. 

2. The default in the Damage Report field of the Compilation Standard screen is 
now 1 – Damage.  Previously the default was 0 – No Damage.  The Ministry of 
Forests requires damaged timber to be included in a compilation as this reduces 
the net volume and provides more accurate stumpage. 

3. The maturity of all blocks in Interior compilations defaults to Mature as there is no 
distinction made in blocks located in the Interior of B.C. Selection of block maturity 
is intended for coastal compilations only. 

4. The interface has been improved to standardize movement in the map area 
statement. The user is now able to use the arrow keys to move between cells.  

5. The user can now delete a line from the percent reduction screen by highlighting a 
line and pressing Delete. Previously, the user had to press Ctrl D. 
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6. We have created three new reports that display the damage percentages for the 
summary reports.  These reports are named Extended CP, Block and Type 
reports. 

CRUISECOMP VERSION 2000 

MINISTRY OF FORESTS RECOMMENDED CHANGES:  

1. Damage reporting:  Trees with multiple damage codes will be reported in the damage 
percent for each type of damage that is entered. The contributing volumes of each 
damaged tree will still be based on the most severe damage type.  Previously, each 
tree was reported in only one damage type. 

2. Two new harvesting methods have been added.  What was previously entered as 
Skyline (SL) has now been split into Skyline Clearcut (LC) and Skyline Selective (LS). 

3. Standard Utilization Limits: The utilization standards are being standardized for Coast 
and Interior compilations.  Only these standards will be used for appraisal information.
     

Coastal Mature  min dbh = 17.5, min. top = 15.0  
Immature min dbh = 12.0, min. top = 10.0 

Interior  Mature  min dbh = 17.5, min. top = 10.0 
Exceptions: Pl        min dbh = 12.5 

  Exceptions: Cedar min. top = 15.0 if more than 50% of Red Cedar net volume is 
over 140 years old 

CRUISECOMP will shade out the immature utilization boxes for appraisal cruises 
completed in the Interior to prevent erroneous utilization values from being entered.  
Interior cruises can not have different utilization of mature and immature blocks.  All 
other utilization standards are permitted for compilations that are not for appraisal 
purposes. 
 

4. FIZ/PSYU updates:  Hecate PSYU added in FIZ J 
 Westlake PSYU added in FIZ I 
 Quesnel SSA added in FIZ G 
5. Revised Statistical Formulae:  There has been a significant change statistical 

calculations; particularly in double sampling and fixed area plot compilations.  
Compilations for these two types of cruises will differ from previous years. 

6. Reporting measure and count trees/plot and plots/hectare: The number of measure 
and count trees per plot (excluding live and dead useless) and the number of plots per 
hectare will be reported in the Cutting Permit report. 

7. Blowdown Code amalgamations:  Blowdown codes E and F are combined to report 
code: "E – Down trees".  Blowdown codes G and H are combined to report code: "G – 
Down trees, shattered".  CRUISECOMP also converts old data codes from F to E and 
H to G when data us imported or when opening old *.ccp files. 

8. Updates have been made to the Spruce high-grade percentages. 
9. Percent Immature: A new field has been added to the Cutting Permit, Block and Type 

summaries.  This field reports all of the immature species based on Tree Class and 
Age in Tens. 
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10. Fields added to the Cutting Permit, Block and Type summaries have made the total 
number of fields too large to be accommodated in a single report.  Therefore, only 
those fields that are required are included in the Harvest reports.  Similarly in the 
Cutting Permit, Block and Type summaries, only those fields that are required are 
included.  This allows all fields to be reported on a single page.  

CRUISECOMP VERSION 99.1 

CRUISECOMP PROBLEMS ADDRESSED: 

1. Fire damage code B was causing the risk group of all trees to appear as Risk Group 2 
even when pathological remarks should have resulted in a tree being downgraded to 
Risk Group 3.  This has been fixed. 

2. Previously, for a tree that had all three damage types, blowdown was chosen as the 
damage code regardless of which category was assigned the highest risk group.  If all 
three damage types in a tree are causing the same risk group change, then the damage 
code will be assigned in the order: blowdown, fire, insect. 

3. Some validations were causing illegal operations.  This have been fixed. 
4. Problems were arising when printing damage reports in a non-damage compilation run.  

The printing of damage reports has now been suppressed in a non-damage compilation 
run.  

5. A problem with the short logs compiled switch has been fixed. 
6. Incorrect volumes calculated when stump height was compiled to 0 cm have been 

rectified. 
7. Previously, the export and import of data would cause the age in tens classes 15-25 to 

revert to 20.  This has been fixed. 

CRUISECOMP VERSION 99.2 PATCH 

CRUISECOMP PROBLEMS ADDRESSED: 

1. A bug in the application of the Cedar Rule (used in Purden, Longworth, Robson, 
Monkman and Bowron PSYU's and TFL 30) has been fixed. The bug caused the 
downgrading of risk groups to work incorrectly.   

2. Digital export of report files (*.out) has been repaired.  Data in the printed reports can 
now be digitally reported and sent to the Ministry of Forests.  This should help reduce 
the size of bound reports.  

CRUISECOMP VERSION 99.3 PATCH 

Repairs to CRUISECOMP in patch 99.2 inadvertently introduced some new software 
problems.  Patch 99.3 addresses these subsequent problems. 

CRUISECOMP PROBLEMS ADDRESSED: 

1. The mature Cedar for Table 96 has been repaired.  All plots with a height code >= 41m 
(in card 9) will be assigned a Risk Group 1 for all cedar located in the plot.  If the height 
code is less than 41m a Risk Group 2 will be assigned to all mature trees in the plot. 

2. Incompatible database errors that were occurring have been resolved. 
3. The Quality Class 1 and 2 for Doug-fir trees has been fixed. 
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4. The plot listing report no longer crashes for certain datasets. 
5. The "spiral grain" is now working correctly when using the Interior grade algorithm. 
6. The root rot reports are no longer appear in the "Available to print" window if they are 

not generated. 
7. The "Volumes by plot" report now show "Total" instead of "9999". 
8. All reports can be viewed digitally (*.out files).  These files are only produced after they 

are printed. 
9. The extended stand and stock table no longer crashes for certain datasets. 
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CRUISECOMP VERSION 1999 

MINISTRY OF FORESTS RECOMMENED CHANGES: 

1. Multiple damage compilations are now permitted.  
2. A new root rot summary report is included. 
3. Percent reductions by damage are now permitted. 
4. The Coastal spruce high grade profile is changed. 
5. Some Forest Districts have been amalgamated and others have name changes. 
6. Both the Coastal and Interior grade algorithms have been updated. 
7. Border plots are now be permitted for fixed radius plots. 
8. There are two new tenure descriptions allowed: code ‘4’ - community forest; code ‘B’ 

- timber license. 
9. Version number update to 99.0 will appear on all reports. 
10. The Map Area Statement card type A now permits entry of the cruising agency in 

positions 67-80.  Consequently, the locality description is shorter.  The Cruising 
agency field is labeled “Cruised by” in CRUISECOMP.  This field is now exportable; 
in the past it was not. 

11. "Calculated grade %" has been renamed "Algorithm grade %" on all summary reports. 
 

CRUISECOMP IMPROVEMENTS: 

1. Species listed on the summary reports are now ordered in the traditional manner (i.e. 
Fir, Cedar, Hemlock...), as many CRUISECOMP users are more familiar with this 
method. 

2. Species columns have been made narrower to accommodate more species on each 
report page.  This helps reduce the number of pages in reports - especially in the stand 
and stock tables. 

3. The grades list is now dynamic so that only those grade summaries occurring in the 
cutting permit are included.  This allows room for the inclusion damage % for blowdown, 
fire and insect in the grade summaries. 

4. Damage reports are now separate from the standard summary, and stand and stock 
tables.  This allows the user to streamline the report printing process. Damage reports 
can now be selected separately in the report options dialog screen and previewed or 
printed. 
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CRUISECOMP PROBLEMS ADDRESSED: 

1. The "Forest District" field in the Map Area Statement report is now reporting the correct 
district name. 

2. Count plot validations no longer give incorrect utilization errors.  Validation now checks 
both the exception utilization and compilation standard to ensure that count plot trees 
are permitted for compilation. 

3. The Interior log lengths for average number of logs and number of logs per tree are 
now 5.0 meters instead of 10.0 meters.  

4. Tree count in the "Volume and basal area statistics", "Summary", and "Plot" reports 
double the trees for half and border plots.  This conveys the correct trees/plot 
calculation. 

5. The slight variance in the logic of the Coastal grade algorithm for Cypress grades has 
been fixed. 

6. Errors associated with the Interior grades algorithm have been fixed. 
7.  


